
UNIVERSIDAD PRIVADA DE TACNA 

FACULTAD DE INGENIERÍA 

ESCUELA PROFESIONAL DE INGENIERÍA AMBIENTAL 

TESIS 

“DETERMINACIÓN DE ISLAS DE CALOR URBANO EN LA CIUDAD DE 
TACNA, MEDIANTE EL USO DE IMÁGENES SATELITALES” 

PARA OPTAR: 

TÍTULO PROFESIONAL DE INGENIERO AMBIENTAL 

PRESENTADO POR: 

Bach. Ruddy Astrid Shery Lima Aróstegui 

TACNA – PERÚ 

2021 



Página 2 

 

 

 

Página de jurados 

UNIVERSIDAD PRIVADA DE TACNA 

FACULTAD DE INGENIERÍA 

ESCUELA PROFESIONAL DE INGENIERÍA AMBIENTAL 

 

Tesis 

“DETERMINACIÓN DE ISLAS DE CALOR URBANO EN LA CIUDAD DE TACNA, 

MEDIANTE EL USO DE IMÁGENES SATELITALES” 

 

Tesis sustentada y aprobada el 15 de enero de 2021; estando el jurado calificador 
integrado por: 

 

PRESIDENTE:                        ___________________________________  

                                                Dr. Oscar Segundo Angulo Salas 

 

SECRETARIO:                       ___________________________________  

                      Ing. Anabel Del Rosario Crisosto Fuster 

 

VOCAL:                                  ________________________________  

                      Mtro. Milagros Herrera Rejas 

 

ASESOR:                               ___________________________________  

                      Ing. Carmen Rosa Román Arce 

 

 

 

 



Página 3 

 

 

 

DECLARACIÓN JURADA DE ORIGINALIDAD 

Yo Ruddy Astrid Shery Lima Aróstegui, en calidad de bachiller de la Escuela de Ingeniería 

Ambiental de la Facultad de Ingeniería de la Universidad Privada de Tacna, identificado(a) 

con DNI 73009691 

Declaro bajo juramento que:  
1. Soy autor (a) de la tesis titulada:  

“DETERMINACIÓN DE ISLAS DE CALOR URBANO EN LA CIUDAD DE TACNA, 

MEDIANTE EL USO DE IMÁGENES SATELITALES” 

la misma que presento para optar el:  

Título Profesional de Ingeniero Ambiental 
2. La tesis no ha sido plagiada ni total ni parcialmente, para la cual se han respetado las 

normas internacionales de citas y referencias para las fuentes consultadas.  

3. La tesis presentada no atenta contra derechos de terceros.  

4. La tesis no ha sido publicada ni presentada anteriormente para obtener algún grado 

académico previo o título profesional.  

5. Los datos presentados en los resultados son reales, no han sido falsificados, ni 

duplicados, ni copiados.  

Por lo expuesto, mediante la presente asumo frente a LA UNIVERSIDAD cualquier 

responsabilidad que pudiera derivarse por la autoría, originalidad y veracidad del contenido 

de la tesis, así como por los derechos sobre la obra y/o invención presentada. En 

consecuencia, me hago responsable frente a LA UNIVERSIDAD y a terceros, de cualquier 

daño que pudiera ocasionar, por el incumplimiento de lo declarado o que pudiera encontrar 

como causa del trabajo presentado, asumiendo todas las cargas pecuniarias que pudieran 

derivarse de ello en favor de terceros con motivo de acciones, reclamaciones o conflictos 

derivados del incumplimiento de lo declarado o las que encontrasen causa en el contenido 

de la tesis, libro y/o invento.  

De identificarse fraude, piratería, plagio, falsificación o que el trabajo de investigación haya 

sido publicado anteriormente; asumo las consecuencias y sanciones que de mi acción se 

deriven, sometiéndome a la normatividad vigente de la Universidad Privada de Tacna.  

Tacna, 15 de enero de 2021. 
 
 
 
Ruddy Astrid Shery Lima Aróstegui 
73009691 
 



Página 4 

 

 

 

DEDICATORIA 

 

 

 

 

 

 

 

 

En primera instancia se la dedico a 

Dios, porque me da la sabiduría para 

enfrentar cada reto que se me presentaba y 

agradezco a mis padres y hermanas por su 

apoyo, compresión, confianza y amor en los 

momentos difíciles para motivarme en lograr 

mis objetivos. 

 

 

 

 

 

 

 

 

 



Página 5 

 

 

 

AGRADECIMIENTO 

 

 

 

 

 

El agradecimiento de mi tesis es a mi 

familia que me ha guiado y me ha dado la fortaleza 

de seguir adelante. A la Universidad que me ha 

dado una formación profesional de alto nivel y  a 

mi asesora la Ing. Carmen Róman Arce por su 

asesoría y apoyo en la elaboración de mi tesis.  

 

 

 

 

 

 

 

 

 

 

 

 

 



Página 6 

 

 

 

CONTENIDO 

PÁGINA DE JURADOS 2 

DECLARACIÓN JURADA DE ORIGINALIDAD 3 

DEDICATORIA 4 

AGRADECIMIENTO 5 

RESUMEN 18 

ABSTRACT 19 

INTRODUCCION 20 

CAPÍTULO I PLANTEAMIENTO DEL PROBLEMA 21 

1.1. DESCRIPCIÓN DEL PROBLEMA 21 

1.2. FORMULACIÓN DEL PROBLEMA 21 

1.2.1. Problema General 21 

1.2.2. Problemas específicos 21 

1.3. JUSTIFICACIÓN E IMPORTANCIA DE LA INVESTIGACIÓN 22 

1.4. OBJETIVOS 22 

1.4.1. Objetivo General 22 

1.4.2. Objetivos Específicos 22 

1.5. HIPÓTESIS 22 

1.5.1. Hipótesis General 22 

1.5.2. Hipótesis Específicos 22 

CAPÍTULO II: MARCO TEÓRICO 24 

2.1. ANTECEDENTES DE LA INVESTIGACIÓN 24 

2.2. BASES TEÓRICAS 25 

2.2.1. Islas de calor urbana 25 

a. Tipos en las islas de calor 26 



Página 7 

 

 

 

2.2.2. Ecosistema urbano 27 

a. Requisitos biológicos 28 

b. Requisitos culturales 28 

c. Características del ecosistema urbano 28 

2.2.3. Impactos de la Urbanización 28 

2.2.4. Crecimiento urbano en el Mundo y América 29 

2.2.5. Clima urbano 29 

2.2.1. Componentes de la Atmósfera urbana y atmósfera rural 30 

2.2.2. Cobertura de vegetación 31 

2.2.7. Área verde 31 

2.2.8. Satélite de imágenes Landsat 5-7 32 

2.2.9. Índice de Vegetación Diferencial Normalizado (NDVI) 33 

2.2.10. Método para la estimación TST del Landsat 5 - 7 33 

2.3. DEFINICIÓN DE TÉRMINOS 34 

2.3.7. Islas de calor 34 

2.3.8. Temperatura superficial terrestre (TST) 34 

2.3.9. Temperatura del aire 35 

2.3.10. Índice de Vegetación Diferencial Normalizado (NDVI) 35 

2.3.11. Imágenes satelitales 35 

2.3.12. Temperatura urbana 35 

CAPÍTULO III:  MARCO METODOLÓGÍCO 36 

3.1. TIPO Y DISEÑO DE LA INVESTIGACIÓN 36 

3.1.1. Descriptivo y correlacional 36 

3.1.2. Diseño documental 36 



Página 8 

 

 

 

3.2. ACCIONES Y ACTIVIDADES 36 

3.3. POBLACIÓN Y/O MUESTRA DE ESTUDIO 37 

3.4. OPERACIÓN DE VARIABLES 37 

3.5. TÉCNICAS DE PROCESAMIENTO Y ANÁLISIS DE DATOS 37 

3.5.1. TÉCNICAS DE PROCESAMIENTO 37 

3.5.2. Análisis de datos 37 

3.6. UBICACIÓN DE LA ZONA DE ESTUDIO 38 

3.6.1. Accesibilidad a la zona 39 

3.7. PROCESAMIENTO Y ANÁLISIS DE DATOS 40 

3.7.1. Recolección de información 40 

a. Imágenes satelitales. 40 

b. Información de metodológica. 40 

c. Información de población. 41 

d. Información de estructuras urbanas 42 

e. Información de las características térmicas de los materiales de 

construcción 45 

3.7.2. Procesamiento de imágenes satelitales 46 

a. Corrección Radiométrica 46 

b. Composición de bandas Landsat 5- 7 49 

c. Mosaico de las cuadriculas 50 

3.7.3. Procesamiento de NDVI 56 

a. Clasificación del NDVI 57 

3.7.4. Procesamiento de temperatura 60 

a. Convertir de ND a Radiancia 60 



Página 9 

 

 

 

b. Convertir Radiancia a Temperatura en grados Kelvin 61 

c. Convertir Temperatura de grados Kelvin a grados Celsius 61 

3.7.5. Correlación de temperatura y NDVI 63 

a. Crear grillas en base la zona urbana 63 

b. Registrar valores en la tabla de atributos 63 

c. Cortar en la zona de estudio 63 

CAPÍTULO IV: RESULTADOS 68 

4.1. PROCESAMIENTO DE IMÁGENES SATELITALES 68 

4.1.1. Periodo húmedo 68 

4.1.2. Periodo Seco 69 

4.2. PROCESAMIENTO DE NDVI 70 

4.2.1. Periodo Húmedo 70 

4.2.2. Periodo Seco 72 

4.3. PROCESAMIENTO DE TEMPERATURA 74 

4.3.1. Temperatura atmosférica y superficial 74 

4.3.2. Periodo Húmedo 75 

4.3.3. Periodo Seco 79 

4.4. ANÁLISIS ESTADÍSTICO EN LA CORRELACIÓN LINEAL 83 

4.4.1. Correlación en Periodo Húmedo 84 

4.4.2. Correlación en Periodo Seco 88 

4.5. DETERMINACIÓN DE ISLAS DE CALOR URBANO 92 

4.5.1. Estimación de superficie en la ICU 92 

a. Periodo Húmedo 93 

b. Periodo Seco 93 



Página 10 

 

 

 

4.5.2. Vegetación y temperatura superficial en la ICU 93 

a. Periodo Húmedo 94 

b. Periodo Seco 95 

4.5.3. Islas de Calor Urbano 95 

CAPÍTULO V: DISCUSIÓN 104 

CONCLUSIONES 106 

RECOMENDACIONES 107 

REFERENCIAS BIBLIOGRÁFICAS 108 

ANEXOS 112 

MATRIZ DE CONSISTENCIA 139 

 

CONTENIDO DE FIGURAS 

Figura 1. Representación esquemática de los componentes principales de la 

atmósfera .............................................................................................................................. 26 

Figura 2.Ciudad como ecosistema ........................................................................... 28 

Figura 3.Factores del clima Urbano ......................................................................... 30 

Figura 4.Áreas verdes en espacios públicos en Perú .............................................. 32 

Figura 5. Mapa de ubicación de la zona urbana de Tacna. ..................................... 38 

Figura 6. Cuadriculas que comprenden el Área de Estudio .................................... 39 

Figura 7.Imagen con Gaps e imagen corregida. ...................................................... 46 

Figura 8.Diagrama del Corrector de Escaneo Lineal (SLC) .................................... 47 

Figura 9.Diagrama de la corrección del bandeado .................................................. 48 

Figura 10.Diagrama de Composición de Bandas. ................................................... 50 

Figura 11.Diagrama de corte de Imágenes Satelitales ............................................ 51 

Figura 12.Modelamiento de corte de imagen satelital (ArcGis) ............................... 51 



Página 11 

 

 

 

Figura 13.Diagrama de Unión de las Imágenes Satelitales ..................................... 53 

Figura 14.Modelamiento de unión de imagen satelital.(ArcGis) .............................. 54 

Figura 15. Diagrama de Corte de Zona de Trabajo ................................................. 55 

Figura 16.Modelamiento de corte en la zona de estudio(ArcGis) ............................ 56 

Figura 17. Diagrama de NDVI .................................................................................. 57 

Figura 18.Diagrama de clasificación del NDVI ......................................................... 59 

Figura 19.Modelamiento del NDVI (ArcGis) ............................................................. 60 

Figura 20.Diagrama de Temperatura Superficial Terrestre(TST) ............................ 62 

Figura 21.Modelamiento del TST (ArcGis) ............................................................... 62 

Figura 22.Modelamiento de la correlación NDVI y  TST (ArcGis) ........................... 64 

Figura 23. Diagrama de Correlación entre NDVI y TST .......................................... 65 

Figura 24.Diagrama para el procesamiento de la información. ............................... 66 

Figura 25.Diagrama de cálculo del NDVI y TST con Imágenes Landsat 5 – 7 ....... 67 

CONTENIDO DE TABLAS 

Tabla 1 Características Básicas de las islas de calor urbano superficial y 

atmosférico ............................................................................................................................ 27 

Tabla 2 Composición del aire de la atmosfera rural y urbana ................................. 31 

Tabla 3 Características del Sensor; Landsat 5 - 7 ................................................... 32 

Tabla 4  Acciones y actividades realizadas .............................................................. 36 

Tabla 5  Operación de variables ............................................................................... 37 

Tabla 6  Coordenadas Path y Row de la Ciudad de Tacna ..................................... 40 

Tabla 7 Datos de las imágenes adquiridas desde la USGS .................................... 40 

Tabla 8  Meses Húmedos y Secos de la Ciudad de Tacna ..................................... 41 

Tabla 9  Tacna: Población censada entre el año 2007 y 2017 ................................ 42 



Página 12 

 

 

 

Tabla 10 Material de construcción predominante en las paredes exteriores de las 

viviendas, según Provincia y Distritos .................................................................................. 43 

Tabla 11 Material de construcción predominante en los techos de las viviendas, 

según provincia y distrito de Tacna ...................................................................................... 44 

Tabla 12 Lista de materiales y sus propiedades térmicas a temperatura ambiente.

............................................................................................................................................... 46 

Tabla 13 Datos extraídos de la Metadata de Landsat 5-7 para su calibración ....... 49 

Tabla 14 Coordenadas  para corte de Imagen Satelital. ......................................... 55 

Tabla 15 Rangos de NDVI ........................................................................................ 58 

Tabla 16 Metadata de los sensores Landsat 5-7 para la conversión de ND a 

radiancia ................................................................................................................................ 60 

Tabla 17 Constantes de calibración K1 y K2 ........................................................... 61 

Tabla 18 Información en Landsat 5 (Periodo Húmedo) ........................................... 68 

Tabla 19  Información en Landsat 7 (Periodo Húmedo) .......................................... 68 

Tabla 20 Información en Landsat 5 (Periodo Seco) ................................................. 69 

Tabla 21  Información en Landsat 7 (Periodo Seco)................................................ 69 

Tabla 22 Estimación de superficie y porcentaje en la vegetación sana (Periodo 

Húmedo) ............................................................................................................................... 70 

Tabla 23  Estimación de superficie y porcentaje en la vegetación sana (Periodo 

Seco) ..................................................................................................................................... 72 

Tabla 24  Diferencia de temperatura ambiental y superficial (Periodo Húmedo) .... 74 

Tabla 25  Diferencia de temperatura ambiental y superficial (Periodo Seco) ......... 74 

Tabla 26 Estimación de la clasificación y superficie de la temperatura en el año 

1985 (Periodo Húmedo) ....................................................................................................... 75 

Tabla 27 Estimación de la clasificación y superficie de la temperatura en el año 

1995 (Periodo Húmedo) ....................................................................................................... 75 



Página 13 

 

 

 

Tabla 28 Estimación de la clasificación y superficie de la temperatura en el año 

2005 (Periodo Húmedo) ....................................................................................................... 76 

Tabla 29 Estimación de la clasificación y superficie de la temperatura en el año 

2010 (Periodo Húmedo) ....................................................................................................... 76 

Tabla 30 Estimación de la clasificación y superficie de la temperatura en el año 

2015 (Periodo Húmedo) ....................................................................................................... 77 

Tabla 31 Estimación de la clasificación y superficie de la temperatura en el año 

2019 (Periodo Húmedo) ....................................................................................................... 77 

Tabla 32 Estimación de la clasificación y superficie de la temperatura en el año 

1986 (Periodo Seco) ............................................................................................................. 79 

Tabla 33 Estimación de la clasificación y superficie de la temperatura en el año 

1995 (Periodo Seco) ............................................................................................................. 79 

Tabla 34 Estimación de la clasificación y superficie de la temperatura en el año 

2005 (Periodo Seco) ............................................................................................................. 80 

Tabla 35 Estimación de la clasificación y superficie de la temperatura en el año 

2010 (Periodo Seco) ............................................................................................................. 80 

Tabla 36 Estimación de la clasificación y superficie de la temperatura en el año 

2015 (Periodo Seco) ............................................................................................................. 81 

Tabla 37 Estimación de la clasificación y superficie de la temperatura en el año 

2019 (Periodo Seco) ............................................................................................................. 81 

Tabla 38 Aplicación de prueba de normalidad para correlación (Periodo Húmedo)

............................................................................................................................................... 83 

Tabla 39 Aplicación de prueba de normalidad para correlación (Periodo Seco) .... 83 

Tabla 40 Correlación entre NDVI y Temperatura en el año 1985 (Periodo Húmedo)

............................................................................................................................................... 84 

Tabla 41 Correlación entre NDVI y Temperatura en el año 1995(Periodo Húmedo)

............................................................................................................................................... 85 



Página 14 

 

 

 

Tabla 42 Correlación entre NDVI y Temperatura en el año 2005 (Periodo Húmedo)

............................................................................................................................................... 86 

Tabla 43 Correlación entre NDVI y Temperatura en el año 2010 (Periodo Húmedo)

............................................................................................................................................... 86 

Tabla 44 Correlación entre NDVI y Temperatura en el año 2015 (Periodo Húmedo)

............................................................................................................................................... 87 

Tabla 45 Correlación entre NDVI y Temperatura en el año 2019 (Periodo Húmedo)

............................................................................................................................................... 88 

Tabla 46 Correlación entre NDVI y Temperatura en el año 1986 (Periodo Seco) .. 88 

Tabla 47 Correlación entre NDVI y Temperatura en el año 1995 (Periodo Seco) .. 89 

Tabla 48 Correlación entre NDVI y Temperatura en el año 2005 (Periodo Seco) .. 90 

Tabla 49 Correlación de Spearman entre NDVI y Temperatura en el año 2010 

(Periodo Seco) ...................................................................................................................... 90 

Tabla 50  Correlación entre NDVI y Temperatura en el año 2015(Periodo Seco) .. 91 

Tabla 51 Correlación de Spearman entre NDVI y Temperatura en el año 

2019(Periodo Seco) .............................................................................................................. 92 

Tabla 52 Estimación de las superficies de las ICU en los distritos (Periodo 

Húmedo) ............................................................................................................................... 93 

Tabla 53 Estimación de las superficies de las ICU en los distritos (Periodo 

Húmedo) ............................................................................................................................... 93 

Tabla 54  Estimación de las superficies de la vegetación y temperatura (Periodo 

Húmedo) ............................................................................................................................... 94 

Tabla 55 Estimación de las superficies de la vegetación y temperatura (Periodo 

Seco) ..................................................................................................................................... 95 

Tabla 56 Observación de los ICU,2019 (Periodo Húmedo) ..................................... 96 

Tabla 57 Muestra fotográfica de las islas de calor urbano,2019 (Periodo Húmedo)

............................................................................................................................................... 97 



Página 15 

 

 

 

Tabla 58  Observación de los ICU,2019 (Periodo Seco) .......................................101 

Tabla 59 Muestra fotográfica de las islas de calor urbano,2019 (Periodo Seco) ..101 

Tabla 60  Estación Jorge Basadre - Variables Hidrometeorológica en Humedad 

Relativa ...............................................................................................................................134 

Tabla 61 Estación Jorge Basadre - Variables Hidrometeorológica en Precipitación 

Total Mensual......................................................................................................................135 

Tabla 62 Estación Jorge Basadre - Variables Hidrometeorológica en Temperatura 

Máxima ................................................................................................................................136 

Tabla 63 Estación Jorge Basadre - Variables Hidrometeorológica en Temperatura 

Media...................................................................................................................................137 

Tabla 64 Estación Jorge Basadre - Variables Hidrometeorológica en Temperatura 

Mínima.................................................................................................................................138 

CONTENIDO DE GRÁFICOS 

Gráfico 1.Estimación de superficie en la vegetación sana (Periodo Húmedo) ....... 70 

Gráfico 2. Estimación de superficie en la vegetación sana (Periodo Seco) ............ 72 

Gráfico 3. Dispersión lineal del año 1985 (Periodo Húmedo) .................................. 85 

 Gráfico 4. Dispersión lineal del año 1995 (Periodo Húmedo) ................................. 85 

Gráfico 5.Dispersión lineal del año 2005 (Periodo Húmedo) ................................... 86 

Gráfico 6. Dispersión lineal del año 2010 (Periodo Húmedo) .................................. 87 

Gráfico 7.Dispersión lineal del año 2015 (Periodo Húmedo) ................................... 87 

Gráfico 8.Dispersión lineal del año 2019 (Periodo Húmedo) ................................... 88 

Gráfico 9. Dispersión lineal del año 1986 (Periodo Seco) ....................................... 89 

Gráfico 10. Dispersión lineal del año 1995 (Periodo Seco) ..................................... 89 

Gráfico 11. Dispersión lineal del año 1995 (Periodo Seco) ..................................... 90 

Gráfico 12. Dispersión lineal del año 2010 (Periodo Seco) ..................................... 91 



Página 16 

 

 

 

Gráfico 13.Dispersión lineal del año 2015 (Periodo Seco) ...................................... 91 

Gráfico 14.Dispersión lineal del año 2019 (Periodo Seco) ...................................... 92 

Gráfico 17.Estimación de las superficies de la vegetación y temperatura (Periodo 

Húmedo) ............................................................................................................................... 94 

Gráfico 18. Estimación de las superficies de la vegetación y temperatura (periodo 

seco) ...................................................................................................................................... 95 

CONTENIDO DE MAPAS 

Mapa 1 NDVI entre el año 1985 y 2019 (Periodo Húmedo) .................................... 71 

Mapa 2 NDVI entre el año 1986 y 2019(Periodo Seco) ........................................... 73 

Mapa 3 TST entre el año 1985 y 2019 {Periodo Húmedo) ...................................... 78 

Mapa 4 TST entre el año 1986 y 2019(Periodo Seco)............................................. 82 

Mapa 5 Zonas de Islas de Calor Urbano (ICU), 2019 (Periodo Húmedo) ............... 96 

Mapa 6 Zonas de Islas de Calor Urbano (ICU), 2019 (Periodo Seco) ..................100 

Mapa 7 Estimación de ICU, 1985 (Periodo Húmedo) ............................................112 

Mapa 8 Estimación de ICU, 1995 (Periodo Húmedo) ............................................113 

Mapa 9 Estimación de ICU, 2005 (Periodo Húmedo) ............................................114 

Mapa 10 Estimación de ICU, 2010(Periodo Húmedo) ...........................................115 

Mapa 11 Estimación de ICU, 2015 (Periodo Húmedo) ..........................................116 

Mapa 12 Estimación de ICU, 1986 (Periodo Seco) ...............................................117 

Mapa 13 Estimación de ICU, 1995 (Periodo Seco) ...............................................118 

Mapa 14 Estimación de ICU, 2005 (Periodo Seco) ...............................................119 

Mapa 15 Estimación de ICU, 2010 (Periodo Seco) ...............................................120 

Mapa 16 Estimación de ICU, 2015 (Periodo Seco) ...............................................121 

Mapa 17 Estimación de ICU, 2010 (Periodo Seco) ...............................................122 



Página 17 

 

 

 

Mapa 18 Indice de vegetación de diferencia normalizada, (Periodo Húmedo) .....123 

Mapa 19 Indice de vegetación de diferencia normalizada, (Periodo Seco) ..........124 

Mapa 20  Temperatura superficial terrestre, (Periodo Húmedo) ...........................125 

Mapa 21 Temperatura superficial terrestre, (Periodos Seco) ................................126 

Mapa 22 Correlación entre NDVI y TST, (Periodo Húmedo) .................................127 

Mapa 23 Correlación entre NDVI y TST, (Periodo Seco) ......................................128 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Página 18 

 

 

 

RESUMEN 

 

La ciudad de Tacna, está apreciando el deterioro de la cobertura de vegetación, 

debido al uso excesivo del uso del suelo para el desarrollo urbano. Donde en sus impactos 

ambientales; incremento de la temperatura ambiental, formando así las Islas de Calor 

Urbano (ICU). Las imágenes se adquirieron en base los satélites LANDSAT 5TM y 

LANDSAT 7 ETM. La metodología se realizó con la técnica métrica para obtener la radiancia 

para determinar la temperatura superficial terrestre (TST) y el Índice de Vegetación de 

Diferencia Normalizado (NDVI) a través de la reflectancia. Las imágenes procesadas fueron 

entre periodo húmedo y seco entre (1985 - 2019) con menos a 10% de nubosidad. Las 

zonas con mayor ocurrencia de las ICU según el periodo húmedo y seco es el distrito de 

Tacna y coronel Gregorio Albarracín Lanchipa, en el análisis estadístico su utiliza la 

CORRELACION DE SPEARMAN (Rho de Spearman) la cual es significativa ya que es 

menor a 0,05. 

Palabras Claves: Isla de Calor Urbana, Imágenes LANDSAT 5 TM, Imágenes 

LANDSAT 7 ETM, Método Métrico, NDVI y Temperatura Máximo Térmico (TST) 
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ABSTRACT 

 

The city of Tacna, is appreciating the deterioration of the vegetation cover, due to 

the excessive use of land use for urban development. Where in its environmental impacts; 

increase in environmental temperature, thus forming the Urban Heat Islands (ICU). The 

images were acquired based on the LANDSAT 5TM and LANDSAT 7 ETM satellites. The 

methodology was carried out with the metric technique to obtain the radiance to determine 

the terrestrial surface temperature (TST) and the Normalized Difference Vegetation Index 

(NDVI) through reflectance. The images processed were between the wet and dry periods 

between (1985 - 2019) with less than 10% cloudiness. The areas with the highest 

occurrence of ICUs according to the wet and dry period is the district of Tacna and of Colonel 

Gregorio Albarracín Lanchipa, the statistical analysis uses the SPEARMAN CORRELATION 

(Spearman's Rho) which is significant since it is lower to 0.05. 

Keywords: Urban Heat Island, LANDSAT 5 TM Images, LANDSAT 7 ETM Images, 

Metric Method, NDVI and Maximum Thermal Temperature (TST) 
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INTRODUCCION 

 

La población según el censo 2017, en los distritos urbanos de la ciudad de Tacna, 

Ciudad Nueva, Tacna, Alto de la Alianza, Pocollay, coronel Gregorio Albarracín Lanchipa y 

Calana cuenta con 290 922 habitantes. Cuenta con necesidades básicas como viviendas, 

servicios, vías de transporte y espacio verdes que están descendiendo gradualmente. Los 

vehículos e industrias emiten dióxido de carbono (CO2), óxidos de nitrógeno (NOx), 

compuestos orgánicos volátiles (COVs) y otros contaminantes a la atmósfera. Estos gases 

forman ozono (O3) a través de una reacción química entre los óxidos de nitrógeno (NOx) y 

los compuestos orgánicos volátiles (COVs) bajo la luz solar. El aumento de las temperaturas 

urbanas, junto con una gran cantidad de fuentes de emisiones de NOx y COVs, conducirá 

a una elevada contaminación del ozono dañando la salud humana por enfermedades 

respiratorias y cardiovasculares crónicas. Además, con el calentamiento global y el cambio 

climático, tiene relación entre la Islas de Calor Urbano (ICU) y la formación de ozono se 

expandirá, lo que presenta un riesgo para el bienestar humano. 

Por el debido uso del suelo urbano en actividades comerciales e industriales y la 

implantación de redes viales que satisfacen las necesidades de la población, los espacios 

verdes han ido disminuyendo gradualmente y como resultado, el microclima que se origina 

alrededor de la ciudad cambia provocando el fenómeno islas de calor urbano.  

El presente proyecto de investigación, tiene por objetivo realizar un análisis 

comparativo de las imágenes satelitales entre los periodos de 1985 al 2019, para determinar 

Islas de Calor Urbano en los diferentes distritos de la ciudad de Tacna. La metodología que 

se desarrolló con el uso de imágenes satelitales obtenidas por el sensor del Landsat 5 y 

Landsat 7 de acuerdo al periodo húmedo y seco, se aplicó el método métrico y algoritmo 

que establece la radiancia termal de la Banda 6 del Landsat 5 y la banda 6_ VCID_2 del 

Landsat 7, estos métodos permiten hallar temperaturas superficiales. Así mismo se 

determinó al NDVI como el índice de porcentajes de vegetación de aquellas áreas verdes. 

Las teorías e hipótesis, objetivos, metodología, resultados y conclusiones 

relacionados con este tema se informarán. Finalmente se explica la prueba de la hipótesis 

para verificar si es aceptada o rechazada.  
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CAPÍTULO I 
PLANTEAMIENTO DEL PROBLEMA  

1.1. Descripción del problema 
A la hora de crecer la zona urbana, crece la población y eliminando los entornos 

naturales (ríos, árboles, bosques, etc.) dando paso a la urbanización por la construcción de 

distintas edificaciones donde los materiales de construcción (cemento, asfalto, arena, acero 

y entre otros) absorben el calor durante el día. Algunas estimaciones determinan que las 

ICU podrían ser responsables del 30% de todo el calentamiento global, aunque otros 

estudios dicen que su contribución es mínima.  

De igual manera, Inzunza (2018) define que las islas de calor se perciben a través 

del efecto albedo (reflectividad de la radiación solar), es decir; la nieve refleja entre 80 y 

90% de esta radiación, es decir que absorbe muy poco calor. Mientras que el cemento 

refleja entre un 20 y 30%, las calles representan hasta el 25% por usar el asfalto y reflejan 

apenas un 5% de radiación. Concluimos que los materiales que se usan para construir la 

ciudad absorben el calor, como consecuencia de ello la disminución de vegetación y las 

altas temperaturas en la superficie, donde afecta negativamente el bienestar humano.  

Así mismo durante el día, las superficies duras de color oscuro absorben y 

almacenan el calor y lo liberan al medio ambiente, lo que hace que se sienta más caliente 

durante más tiempo. Por la noche la temperatura del aire comienza a enfriarse, aunque las 

superficies siguen liberando el calor almacenado, el aumento de temperatura por la noche 

hace que nos sea más difícil en el instante de un sueño reparador, sin ventiladores y aires 

acondicionados en funcionamiento. 

1.2. Formulación del problema 
1.2.1. Problema General  

¿Cómo determinar Islas de calor urbano en la Ciudad de Tacna? 

1.2.2. Problemas específicos 
• ¿Cuáles son las características térmicas de los materiales de construcción y 

como están relacionados con la temperatura urbana? 

• ¿En qué medida la escasez de vegetación se relaciona con el aumento de 

Islas de Calor? 

• ¿Cómo se relaciona la temperatura superficial, del aire y el NDVI en las Islas 

de Calor? 
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1.3. Justificación e Importancia de la Investigación 
En la década del 40 del siglo XX, el crecimiento de la población Tacneña crece de 

manera constante, especialmente por ingresos migratorios. Este crecimiento de la 

población es de 329 332 habitantes (en distritos en Tacna, Alto de la Alianza, Ciudad 

Nueva, Coronel Gregorio Albarracín Lanchipa y Pocollay). Según el INEI Tacna ocupa el 

puesto 23 entre los distintos sectores del país.  

En la presente tesis se aplica; la corrección radiométrica y la composición de bandas 

de cada imagen satelital, para desarrollar algoritmos y calcular el NDVI y TST, se utiliza 

programas como el ArcGIS y ENVI, todos son la base para obtener resultados. Del mismo 

modo, desde una perspectiva económica, el proyecto es razonable, ya que se desarrolla 

por una Laptop y solo se hará monitoreos para verificar la información procesada en campo. 

Finalmente, se realiza una prueba estadística; la correlación de Spearman (Rho de 

Spearman) que se usa para datos que no tiene distribución normal. 

1.4. Objetivos 
1.4.1. Objetivo General 

• Realizar un análisis comparativo de las imágenes satelitales entre los 

periodos de 1985 al 2019, para determinar Islas de Calor Urbano en los 

diferentes distritos de la ciudad de Tacna.  

1.4.2. Objetivos Específicos 
• Determinar las características térmicas de los materiales de construcción y 

establecer su relación con la temperatura urbana. 

• Establecer la relación que existe entre la escasez de vegetación con el 

aumento de islas de calor mediante la generación de algoritmos con el uso 

de imágenes satelitales. 

• Determinar la relación existente entre las islas de calor, la temperatura 

superficial y el NDVI, en la Ciudad de Tacna. 

1.5. Hipótesis 
1.5.1. Hipótesis General 

• Existen una variación de temperatura entre los años 1985 y 2019, para 

determinar Islas de Calor Urbano en la Ciudad de Tacna  

1.5.2. Hipótesis Específicos  
• H1: Las Islas de Calor están relacionadas significativamente con las 

propiedades de los materiales de construcción.  

https://es.wikipedia.org/wiki/Distrito_de_Alto_de_la_Alianza
https://es.wikipedia.org/wiki/Distrito_de_Ciudad_Nueva
https://es.wikipedia.org/wiki/Distrito_de_Ciudad_Nueva
https://es.wikipedia.org/wiki/Distrito_de_Coronel_Gregorio_Albarrac%C3%ADn_Lanchipa
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• H2: Existe una relación significativa entre la escasez de vegetación con el 

aumento de islas de calor. 

• H3: Las islas de calor se relacionan significativamente con la temperatura 

superficial y el NDVI. 
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CAPÍTULO II: 
MARCO TEÓRICO  

2.1. Antecedentes de la investigación  
(Soberón & Obregón,2016), en el proyecto de investigación “Identificación de las 

islas de calor en la ciudad de Lima metropolitana utilizando imágenes satelitales LANSADT 

(5TM)”, como objetivo es identificar las islas de calor urbano superficial de la ciudad de Lima 

y su relación con la temperatura del aire. El tipo y diseño del proyecto es no experimental, 

correlacional y descriptivo. La metodología consiste en encontrar radiancias con los datos 

de las imágenes de satélite LANSADT (5TM) para luego hallar la temperatura de brillo la 

cual fue corregida por la emisividad. Las imágenes satelitales pertenecieron en los meses 

de enero (2012), marzo (2011) y abril (2009) el área de estudio se consideró en zona urbana 

y rural donde se reconoce tres tipos de uso de suelo comercial, industrial y suelo desnudo. 

Se halla el NDVI con dos bandas para tener una respuesta espectral, así mismo para hallar 

las temperaturas superficiales terrestres se desarrolló previamente un realce de las 

imágenes que permiten diferenciar entre los suelos desnudos y con vegetación. Para 

determinar las islas de calor dependerá de su temperatura mayor teniendo en consideración 

al promedio hallada en el área urbana. Finalmente se identificó 15 islas de calor en la zona 

urbana, las cuales se encuentran en los distritos de Villa María del Triunfo, Villa el Salvador, 

San Juan de Miraflores San Juan de Lurigancho, así mismo la relación entre en NDVI y la 

temperatura de superficie es negativa, cuya regresión es 0.89 puesto que mientras mayor 

sea la existencia de cobertura vegetal la temperatura de superficie será menor. 

En la investigación científica  “Utilización de imágenes satelitales para el estudio de 

la distribución térmica en distintas coberturas del suelo de la ciudad de Bahía Blanca 

(Argentina) propuesta de los autores  (Ferrelli, Bustos, Huamantinco Cisneros, & Piccolo, 

2015) cuyo objetivo es analizar el comportamiento de la Temperatura de Superficie 

Terrestre (TST) en relación con las distintas áreas urbanas demostró que presentan 

sectores que incluyen estructuras edilicias, espacios verdes, suelos al descubierto, tránsito 

vehicular, necesidades calóricas de la ciudad y diferentes coberturas de sombras. Se 

analizaron con imágenes satelitales en Landsat 5 TM y 7 ETM+ con el método monocanal. 

Los mayores valores de TST se localizaron en la periferia (45,1°C) y en urbano muy 

disperso (46°C) y el menor en el centro de la ciudad (2°C). Las distintas coberturas del suelo 

generaron menores fluctuaciones de TST en invierno (>5°C) y las mayores en verano (entre 

15 y 25°C). 

La tesis “Disminución de las áreas verdes, en la aparición de islas de calor en la 

ciudad de Iquitos entre los años 2004 – 2014. Región Loreto de (Francis, 2015) tiene como 
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objetivo evaluar la influencia de la disminución de áreas verdes en la aparición de islas de 

calor en la ciudad de Iquitos durante la última década. La metodología presentada del 

cálculo de NDVI y método de estimación de temperatura superficial (TST) como resultado 

se determinó una pérdida de cobertura vegetal del 15% del área total de la ciudad de Iquitos 

en el periodo del 2005 al 2014, con una tasa de pérdida del 2.22% anual. Donde con las 

pocas áreas verdes disminuyen las temperaturas de la ciudad de Iquitos, en especial, los 

sectores del Fuerte Militar Vargas Guerra y San Roque (Aeropuerto). 

Así mismo, (Soto, Garzon, & Jimenez, 2019) realizaron del mismo tema de las islas 

de calor urbano (UHI) mediante el uso de imágenes Landsat en la cual se va caracterizar y 

detectar la relación con la perdida de vegetación, donde se usará las técnicas de 

discriminación de coberturas y un algoritmo mono-canal donde usa para la corrección la 

temperatura de brillo y finalmente se aplicará la técnica de regresión para obtener la 

correlación entre temperatura y vegetación. Como resultado se demostró la correlación 

entre la temperatura superficial del suelo (LST) y el índice de vegetación de diferencia 

normalizada (NDVI) asociada una fuerte aparición UHI en la zona sureste de la ciudad, las 

LST de menor intensidad se hallaron en áreas con alto NDVI, esta correlación negativa 

entre LST y NDVI indicó que a medida que una aumenta la otra reduce. La cobertura del 

suelo tiene relación directa con la LST, lo cual puede ayudar a la planificación de su uso. 

De igual manera el gobierno local de la ciudad propuso en la incrementación de zonas 

verdes en los lugares que concentren de mayor población Para reducir los efectos de UHI 

el gobierno local debe incrementar la cantidad de áreas verdes en las zonas de mayor 

concentración poblacional. 

Cabe mencionar que, a nivel local, no se ha registrado documentos que validen la 

presente investigación. 

2.2. Bases Teóricas 
2.2.1. Islas de calor urbana 

Según el periódico Universal de Querétaro por el ex rector Garrido, (2015) lo define 

“El término isla en calor urbano se utiliza para describir el calor característico de la 

atmósfera y la ciudad o la superficie de la ciudad en comparación con los entornos no 

urbanizados.”  
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a. Tipos en las islas de calor 

De acuerdo con (Voogt, s.f.) se observa en la siguiente imagen la representación 

esquemática de los componentes principales de la atmósfera urbanas, en las cuales son 

simbolizadas de la siguiente manera:  

• La capa de dosel (CDU): Es la capa de aire en las ciudades que está más 

cercana a la superficie, la cual se extiende a una altura media de las 

edificaciones. 

• La capa perimetral (ICCP): Es la capa urbana la cual puede ser de 1 

kilómetro (km) o más de espesor durante el día, y se encoge en metros 

durante la noche. 

• La capa superficial (ICS): Es la capa donde se forma a una cúpula de aire 

donde tiene una temperatura caliente que se extiende en dirección del viento 

en la ciudad.  

Fuente: Elaboración propia en base de (Voogt, s.f.) 

De acuerdo con el libro Reducción de las islas de calor urbano: Capítulo 1. 

Conceptos básicos de la isla de calor urbano publicadas por la Agencia de Protección 

Ambiental, 2008 se centraliza que las islas de calor urbanas superficiales y atmosféricas se 

difieren en la forma en que se constituyen en la identificación, medición y sus impactos. En 

la siguiente tabla se resume detalladamente las características básicas de cada tipo de isla 

de calor.  

 

 

Figura 1. Representación esquemática de los componentes principales de la 

atmósfera 



Página 27 

 

 

 

Tabla 1 

Características Básicas de las islas de calor urbano superficial y atmosférico 

 Fuente: (Agencia de Protección Ambiental, 2008) 
 

2.2.2. Ecosistema urbano  

Barrios (2012) Un ecosistema urbano es un entorno creado por el hombre. Ciudades 

que utiliza la luz eléctrica, hormigón, ladrillo, metal, alquitrán y plásticos.  
 

 

 

 

 

 

Características Superficie Atmosférico 
Desarrollo Temporal  ● Se presenta durante el 

día y noche.  
● La intensidad dura en 

los meses y días.  

● Puede ser corto, ya que no 
puede durar en el día  

● Mayor intensidad se da en la 
noche o por la mañana en 
invierno.  

Intensidad Máxima 
de temperatura  
 

Mas variación temporal  
● Día: 18 a 27 ºF 

(-1 a 2ºC)  
● Noche: 9 a18 ºF 

(5 a 10ºC)  

Variación Mínima  
● Día: -1,8 a 5,4 ºF (-1 a 2ºC)  
● Noche: 12,6 a 21,6 ºF (7 a 12 

ºC)  

Método de 
identificación 

● Medición 
indirecta  

● Sensor Remoto  

● Estaciones meteorológicas 
fijas  

● Transeptos (puntos medidos 
en una determinada 
distancia) Móviles.  

Características  Superficie UHI  Atmosférica UHI  
Descripción Imagen Termal  ● Mapa de Isotermas  

● Gráficos de Temperatura  
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Fuente: (Julen, 2011)  
 

 Mervaesm (2018) define que, al analizar los ecosistemas urbanos, se deben 

considerar; requisitos y características: 

a. Requisitos biológicos 

Las personas tienen la necesidad del uso de los ecosistemas. Por ejemplo, necesita 

aire, agua, espacio, energía (alimentos y calor), refugios y áreas para eliminar los desechos.  

b. Requisitos culturales 

 La cultura es un estilo de vida de la humanidad y la prolonga a todas las 

generaciones. La presencia de los ecosistemas urbanos puede ayudar a las personas a 

cumplir con sus requisitos culturales. Por lo tanto, cuanto más complejo sea su avance 

cultural, ya sea por tecnología, transporte o comunicación, la humanidad tendrá que 

construir una ciudad más grande.  

c. Características del ecosistema urbano 

• Los procesos y comportamientos humanos (estilos de vida, sistemas de 

producción y transporte, formas urbanas) donde se relaciona en el desarrollo 

de los recursos naturales e impactos directos e indirectos sobre el medio 

ambiente. 

• El nivel de productores es cero, porque los alimentos provienen de fuentes 

externas.  

• Entre los consumidores, los humanos y animales viven en la ciudad. 

2.2.3. Impactos de la Urbanización  

Figura 2.Ciudad como ecosistema 
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De acuerdo con Satterthwaite (1993) al momento del desarrollo urbano destruye los 

ecosistemas y el medio ambiente: 

• Destruye el ecosistema y sus funciones. 

• Destruye los factores biológicos en el ecosistema urbano.  

• Contaminación del suelo, aire, agua y etc.  

• Implantación de plantas y animales no nativos en áreas naturales. 

• Incremento a la exposición humana a enfermedades. 

• Posibles riesgos de inundaciones y erosión del suelo debido al uso de la 

tierra. 

• Reducción de las aguas subterráneas producto al uso del suelo en las 

superficies de carreteras, donde evita que el agua se filtre bajo tierra.  

2.2.4. Crecimiento urbano en el Mundo y América  
Actualmente, la población mundial alcanzará los 9.035 millones de habitantes., 

para el 2050. De acuerdo con (INEI;UNFPA, 2020) A nivel mundial, el país más grande es 

Rusia, seguido de Canadá, Estados Unidos y China. El Perú ocupa el puesto 19 entre los 

países con mayor superficie, obtiene el séptimo país más poblado de América con 32 626 

habitantes. El primero de la región es Estados Unidos con más de 331 millones, seguido 

por el gigante de América del Sur, Brasil con 213 millones y México con 129 millones de 

habitantes. 

2.2.5. Clima urbano 
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Según el autor Wypych (2004) define el clima urbano con los siguientes factores 

naturales; se manifiesta a gran escala (por ejemplo; latitud) o de mediana escala (por 

ejemplo; terreno, cuerpo de agua). Con el desarrollo de las ciudades, donde aparece 

algunos factores nuevos que han cambiado el clima local de la ciudad y han ayudado a 

formar diferentes climas urbanos. 

Fuente: Elaboración propia. 

2.2.1. Componentes de la Atmósfera urbana y atmósfera rural 
Según el autor Guerrero, (2018) la atmósfera urbana tiene una diferencia con la 

rural; donde practica modificaciones en el paisaje, lo que provoca cambios en la atmósfera. 

En la siguiente tabla se visualiza las diferencias de composición del aire en el aspecto rural 

y urbano. 

 

 

 

CLIMA URBANO

COBERTURA 
VEGETAL

TOPOGRAFI
A

NUMERO DE 
HABITANTES

TAMAÑO Y 
ESTRUCTUR

A DE LA 
CIUDAD

CUERPOS DE 
AGUA

EMISIONES 
DE CALOR 

ANTROPOGE
NICO

EMISIONES 
GASEOSAS

LATITUD

Figura 3.Factores del clima Urbano 
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 Tabla 2 

Composición del aire de la atmosfera rural y urbana 

Fuente: (Agencia de Protección Ambiental, 2008) 

2.2.2. Cobertura de vegetación 
En base de la Agencia de Protección Ambiental (2008) la cobertura de vegetación 

es considerada en las zonas rurales, vegetación y la tierra donde suelen ser las partes 

principales del paisaje, porque los árboles y la vegetación puede favorecer sombras, donde 

reduce la temperatura de la superficie. También ayuda a bajar la temperatura del aire a 

través de un proceso llamado evapotranspiración, disipando así el calor circundante. En 

contraste, las áreas urbanas se caracterizan por superficies estructuralmente secas e 

impermeables, como techos tradicionales, aceras, caminos y estacionamientos.  

2.2.7. Área verde 
De acuerdo con el Ministerio del Ambiente, (2018) las áreas verdes es un espacio 

público compuesto de vegetación (césped, árboles y arbustos). El espacio verde es esencial 

para el desarrollo urbano sostenible (por ejemplo; los parques, las plazas y los árboles 

urbanos) no solo definen en gran medida las características y el atractivo de la ciudad. Estos 

espacios abiertos también ayudan a mejorar la calidad de vida de los residentes.  

En la sección de la estadística Municipal, (2016) obtenidos de acuerdo al año 2015, 

en la provincia de Lima ocupa el primer puesto con 29 729 352 m2 de áreas verdes y a 

Tacna ocupa el puesto dieciséis con 928 215 m2. Estos datos se cambiaron a números 

generales a porcentajes, donde se estima que Tacna representa el 3 % contra la Provincia 

Atmosfera Rural Atmosfera Urbana 

Mezcla de gases: N2, O2, Ar, CO2 y otros 

Partículas sólidas y liquidas en suspensión (polvo, humos, cenizas, sales, etc.) 

 

SO2, NO, NO2, CO, etc. 

Compuestos orgánicos 

Productos fotoquímicos (O2) 

Aerosoles (Al, As, C, Cd, Cr, Cu, Fe, Mn, Ni, Pb, 

Ti, V, etc)  
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de Lima que es el 97 % en áreas verdes en espacios públicos (Parques, Bermas, Plazas, 

Jardines, óvalos, alamedas, parques zonales y zoológicos).  

Fuente: (Estadística Municipal, 2016) 
 

2.2.8. Satélite de imágenes Landsat 5-7 
Landsat 7(sensor ETM+) posee ocho bandas multiespectrales y Landsat 5 (sensor 

TM) tiene siete bandas multiespectrales que van desde el visible hasta el infrarrojo medio, 

con una resolución de 30 metros, en la mayoría de ellas. La diferencia entre ellas está en 

que las Landsat 7 poseen una banda pancromática de 15 metros y en el caso de la banda 

termal, aumenta la resolución de 120 a 60 metros. Cada escena cubre 180*175 Km2.  

Tabla 3 

Características del Sensor; Landsat 5 - 7 
 LANDSAT 5 LANDSAT 7 

Modo 

espectral 
Multiespectral y Termal Multiespectral y Pancromática 

Espacial 

(metros) 
30 - 120 30- 15 

Radiométrica 8 bits 8 bits 

Temporal 16 días 16 días 

Espectral 

(micras) 

Banda 1 azul 0.45 – 0.52 Banda 1 azul 0.45 – 0.52 

Banda 2 verde 0.52 – 0.60 Banda 2 verde 0.53 – 0.60 

Banda 3 roja 0.63 – 0.69 Banda 3 roja 0.63 – 0.69 

Banda 4 
infrarrojo 
cercano 1 

0.76 – 0.90 
Banda 4 infrarrojo 

cercano 1 
0.77 – 0.90 

Banda 5 
Infrarrojo 
cercano 2 

1.55 – 1.75 
Banda 5 Infrarrojo 

cercano 2 
1.55 – 1.75 

Provincia 
de Lima

97%

Tacna
3%

Figura 4.Áreas verdes en espacios públicos en Perú 
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Banda 6 

Infrarrojo 

térmico 

10.4 – 12.5 
Banda 6 Infrarrojo 

térmico 
10.4 – 12.5 

Banda 7 

Infrarrojo medio 
2.08 – 2.35 

Banda 7 Infrarrojo 

medio 
2.09 – 2.35 

Banda 8: 

Pancromática 
520 – 900 

Fuente: INEGI. Dirección General de Geografía y Medio Ambiente 

2.2.9. Índice de Vegetación Diferencial Normalizado (NDVI) 
(Eugene, 2020) afirma que el NDVI se utiliza para cuantificar el verdor de la 

vegetación, comprender la densidad de la vegetación y evaluar los cambios en la salud de 

las plantas. Se afirma que al momento de obtener el NDVI debe tener una escala de –1 a 

+1 donde los valores menores de cero representan ausencia de vegetación. 

Se calcula con la siguiente ecuación para hallar el NDVI:  

Ecuación 1. NDVI 

𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁:
𝑁𝑁𝑁𝑁𝑁𝑁(𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵 4) − 𝑁𝑁(𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵 3)
𝑁𝑁𝑁𝑁𝑁𝑁(𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵 4) + 𝑁𝑁(𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵𝐵 3)

 

Donde:  

NIR: Reflectancia del Infrarrojo Cercano  

R: Reflectancia del Rojo visible 

2.2.10. Método para la estimación TST del Landsat 5 - 7  
Para determinar la temperatura superficial, se realiza utilizando los Landsat 5 – 7 en 

la cual se realiza los siguientes pasos para obtener las TST (Fernandes & de Sousa, 2013) 

Paso 1: Selección de imágenes satelitales mediante cuadrantes por la longitud y 

latitud que son posiciones geográficas.  

Paso 2: Conversión ND a Radiancia 

Ecuación 2.ND a Radiancia  

𝐿𝐿𝜆𝜆 =
𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝜆𝜆 − 𝐿𝐿𝐿𝐿𝑁𝑁𝑁𝑁𝜆𝜆

𝑄𝑄𝑄𝑄𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿 − 𝑄𝑄𝑄𝑄𝐿𝐿𝐿𝐿𝐿𝐿𝑁𝑁𝑁𝑁 ∗ (𝑄𝑄𝑄𝑄𝐿𝐿𝐿𝐿 − 𝑄𝑄𝑄𝑄𝐿𝐿𝐿𝐿𝐿𝐿𝑁𝑁𝑁𝑁) + 𝐿𝐿𝐿𝐿𝑁𝑁𝑁𝑁𝜆𝜆 

Donde: 

Lλ: Radiancia espectral 
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QCAL: Cuantificar calibrar valor de píxel en Número Digitales (DN) 

LMAXλ: Escala de radiancia espectral a QCALMAX en (Watts/(m2*sr*μm)) 

LMINλ: Escala de radiancia espectral a QCALMIN en (Watts/(m2*sr*μm)) 

QCALMIN: Mínimo cuantificar calibrar valor de píxel (correspondiente a 

LMINλ) en DN 

QCALMAX: Máximo cuantificar calibrar valor de pixel (correspondiente a 

LMAXλ) en DN 

Paso 3: Conversión Radiancia a Temperatura en grados Kelvin 

Ecuación 3.Temperatura en grados Kelvin (K) 

𝑇𝑇 =
𝐾𝐾2

𝑙𝑙𝐵𝐵 (𝐾𝐾1
𝐿𝐿𝜆𝜆

+ 1)
 

Donde: 

T: Temperatura Efectiva en el satélite en Kelvin 

K2: Calibración constante 2 

K1: Calibración constante 1 

Lλ: Radiancia Espectral en (Watts/(m2*sr*μm)) 

Paso 4: Conversión de Temperatura de grados Kelvin a grados Celsius 

Ecuación 4.Conversión a Celsius (°C) 
𝑄𝑄 = 𝐾𝐾 − 273.15 

Donde: 

°C: Temperatura en grados Celsius 

°K: Temperatura en grados Kelvin 

2.3. Definición de términos 
2.3.7. Islas de calor 

Son zonas al azar que contiene temperaturas altas ya sea del aire y la superficial 

terrestre donde puede traer consecuencias graves por salud a los habitantes de la ciudad. 

(Garrido, 2015)  

2.3.8. Temperatura superficial terrestre (TST) 
Es una medida del calentamiento directo de la superficie terrestre, donde los rayos 

del sol son absorbidos y re emitidos. (Greenurbandata, 2019) 
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2.3.9. Temperatura del aire 
La temperatura atmosférica o aire son elementos constitutivos del clima que se 

refiere al grado de calor específico del aire en un lugar y momento determinados, así como 

la evolución temporal y espacial de dicho elemento en las distintas zonas climáticas. 

Constituye el elemento meteorológico más importante en la delimitación de la mayor parte 

de los tipos climáticos. (Greenurbandata, 2019) 

2.3.10. Índice de Vegetación Diferencial Normalizado (NDVI) 
Se utiliza para la cantidad, calidad y desarrollo de la vegetación con base a la 

medición de la intensidad de la radiación de ciertas bandas del espectro 

electromagnético que la vegetación emite o refleja. (Alonso, 2015) 

2.3.11. Imágenes satelitales 
Las imágenes satelitales permiten en la elaboración general de mapas, en la 

adquisición y visualización de datos en los sistemas de información geográfica. 

(BASTERRA, 2011) 

2.3.12. Temperatura urbana 
Es la alteración de los factores naturales, a medida que la ciudad crece y se 

desarrolla la contaminación atmosférica; la sobrepoblación y las emisiones de calor 

producidos por el hombre, la ciudad está construido principalmente por hormigón, asfalto, 

ladrillos y piedras) hacen que la temperatura de la ciudad sea mayor que una zona rural 

nuevos factores (contaminación atmosférica, efecto invernadero, calentamiento global) 

(Givoni, 1998) 
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CAPÍTULO III:  
MARCO METODOLÓGÍCO  

3.1. Tipo y diseño de la investigación  
3.1.1. Descriptivo y correlacional 

En el aspecto demostrativo implica en la observación y descripción de eventos 

relacionados con el problema general, Así mismo en el aspecto correlacional, consiste en 

medir el grado de asociación entre variables dependientes.Ninguna de estas variables es 

fijada o manipulada por el investigador en la cual requiere de hipótesis y aplicación de 

prueba estadística.  

3.1.2. Diseño documental  
La información que serán para la redacción y comparación de resultados en la 

hipótesis y justificación serán obtenida a través de documentos preseleccionados de 

distintos autores de investigación.  

3.2. Acciones y actividades  
Las acciones y actividades se muestran en la siguiente tabla. 

Tabla 4  

Acciones y actividades realizadas 

Fuente: Elaboración propia. 
 

Acción Actividad 

Determinar variación de temperatura 
entre los años 1985 – 2019. 

Descargar imágenes satelitales Landsat. 

Determinar la temperatura superficial. 

Analizar NDVI de los años 1985 – 2019. 
Descargar imágenes satelitales Landsat. 

Determinar NDVI. 

Realizar la correlación de datos de 
temperatura y NDVI. Procesamiento estadístico de la información. 

Determinar las Islas de Calor Urbano. Realizar y procesar la información para determinar 
las Islas de Calor Urbano. 

Salida de campo. Verificar la información procesada en campo. 

Análisis estadístico de la información 
elaborada. 

Realizar un análisis estadístico de toda la 
información procesada para calibrar el modelo 

Elaborar el informe final. Culminar la redacción del informe hasta las 
conclusiones. 
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3.3. Población y/o muestra de estudio 
El presente trabajo de investigación abarca como zona de estudio al departamento 

de Tacna, que tiene un área de 16033.77 Km2, esto representa la población y la muestra 

tiene un área de 73.32 Km2, que corresponde a la zona urbana de la ciudad de Tacna, no 

se tomó una muestra.  

Los distritos seleccionados son: Distrito de Tacna, Distrito de Coronel Gregorio 

Albarracín Lanchipa, Distrito Alto de la Alianza, Distrito de Ciudad Nueva, Distrito de 

Pocollay y el Distrito de Calana.  

3.4. Operación de variables 
La siguiente tabla nos muestra la operación de variables 

Tabla 5  

Operación de variables 

Variables Concepto Indicadores Técnicas e instrumentos 

 
VI. Temperatura y 
Índice de calor 
Normalizado 

Los cambios de 
temperatura y la 
vegetación están 
asociados a las Islas de 
calor urbano 

- Temperatura. 
- Vegetación 

 

- Información de Senamhi 
- Uso de software para la 

elaboración de mapas 
temáticos 

- Imágenes satelitales 
 

 
VD. Islas de calor 
urbano 

- Temperatura. 
- Vegetación 

 

- Uso de software para la 
elaboración de mapas 
temáticos 

- Imágenes satelitales 
Fuente: Elaboración propia. 

3.5. Técnicas de procesamiento y análisis de datos  

3.5.1. Técnicas de procesamiento 
Las técnicas en el procesamiento de la investigación fueron las siguientes: 

- Procesamiento de la información de Senamhi, INEI y Zonificación Ecológica 

y Económica (ZEE) de la Región de Tacna. 

- Delimitación de zona de estudio. 

- Elaboración de mapas temáticos. 

- Elaboración de mapas temáticos para la evaluación de temperatura y NDVI 

3.5.2. Análisis de datos 
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Primero se recolecto la información bibliográfica y la base legal para poder tener una 

mejor perspectiva del trabajo a realizar, se realizó la búsqueda de conceptos relacionados 

con el tema, así como la metodología empleada por otros autores, luego se crearon cuadros 

para el análisis de susceptibilidad, peligros y finalmente vulnerabilidad y riesgo. También se 

realizó el análisis estadístico de los indicadores, de igual manera de los mapas temáticos 

realizados en la zona de estudio. 

3.6. Ubicación de la zona de estudio  

 Fuente: Elaboración propia. 

 

 

Figura 5. Mapa de ubicación de la zona urbana de Tacna. 
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3.6.1. Accesibilidad a la zona  
Para obtener la accesibilidad de la zona de estudio será mediante el uso de 

imágenes satelitales, que fueron adquiridas por “Earth Explorer”, del servicio geológico de 

los Estados Unidos (http://earthexplorer.usgs.gov/), donde se descargaron por un periodo 

comprendido entre el año 1985 y 2019, se utiliza las imágenes correspondientes a los 

meses de su periodo climatológico; Húmedo (Febrero, Marzo, Abril, Mayo y Diciembre) y 

Seco (Julio, Agosto, Septiembre, Agosto). Para lograr abarcar la totalidad del área en 

estudio, se requirió la descarga de 2 cuadriculas, como se muestra en la Figura 6.  

 

Fuente: Elaboración propia 

En la siguiente tabla se muestra los datos de las cuadriculas que fueron ubicadas 

por el “Path” y “Row” (órbita y punto) donde fue utilizado para la ubicación de la Ciudad de 

Tacna.   

Figura 6. Cuadriculas que comprenden el área de Estudio 

http://earthexplorer.usgs.gov/
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Tabla 6  

Coordenadas Path y Row de la Ciudad de Tacna 
LANDSAT Path Row 

Ciudad de Tacna  002 
072 

073 

Fuente: Elaboración Propia. 

3.7. Procesamiento y análisis de datos 
Para el procesamiento y análisis de datos se trabajó en la forma que detallamos a 

continuación. 

3.7.1. Recolección de información 
a. Imágenes satelitales.  

Se trabajo con las imágenes del satélite Landsat, como se muestra a continuación: 

Tabla 7 

Datos de las imágenes adquiridas desde la USGS 

Fuente: Elaboración propia. 
 

b. Información de metodológica. 

La ciudad de Tacna es dominado clima ecuatorial. Es decir, es muy caluroso, 

húmedo y lluvioso durante todo el año. La temperatura media anual en Tacna es 23° 

(grados) y la precipitación media anual es 16 mm (milímetro). No llueve durante 334 días 

por año, la humedad media es del 77% y el Índice UV es 6. En la tabla 8 con la información 

de SENAMHI define los meses dominados secos y húmedos. 

Periodo húmedo Periodo seco 

Fecha  Landsat Sensor Hora  Fecha  Landsat Sensor Hora  

28/03/1985 L5 TM 14:12 21/07/1986 L5 TM 14:04 

24/03/1995 L5 TM 13:51 2/10/1995 L5 TM 13:42 

19/03/2005 L5 TM 14:28 26/08/2005 L5 TM 14:29 

13/02/2010 L5 TM 14:32 7/07/2010 L5 TM 14:32 

8/04/2015 L7 ETM 14:40 15/09/2015 L7 ETM 14:30 

31/12/2019 L7 ETM 14:22 12/10/2019 L7 ETM 14:26 
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Tabla 8  

Meses Húmedos y Secos de la Ciudad de Tacna 

Fuente: Elaboración Propia. 
 

c. Información de población. 

De acuerdo el Censo (2007 – 2017) se procede en extraer la información de los 

datos de población para así evaluar el incremento poblacional.  

Censo 2007:  

En la provincia Tacna del censo 2007 (Ver tabla 10) tiene un total de 262 731de 

población y los distritos de la ciudad de Tacna con mayor población censada son: Distrito 

de Tacna con 94 428 habitantes (35.9%), coronel Gregorio Albarracín Lanchipa con 68 989 

habitantes (26.3%), Distrito Alto de la Alianza con 35 439 habitantes (13.5%), Distrito 

Ciudad Nueva con 34231 habitantes (10.4%), Distrito Pocollay con 17 113 habitantes 

(6.5%). El distrito de menor población es el Distrito Calana con 2 625 habitantes (1.0%)  

Censo 2017: 

En la provincia Tacna del censo 2017 (Ver tabla 10) tiene un total de 306 363 de 

población y los distritos de la ciudad de Tacna con mayor población censada: Distrito 

Coronel Gregorio Albarracín Lanchipa con 110 417 habitantes (36.04%), Distrito de Tacna 

con 92 972 habitantes (30.35%), Distrito Alto de la Alianza con 34 061 habitantes (11.12%), 
Distrito Ciudad Nueva con 31 866 habitantes (10.4%), Distrito Pocollay con 18 627 

habitantes (6.08%). El distrito de menor población es el Distrito Calana con 2 979 habitantes 

(0.97%). 

 

 

 

Zona 
Mes 

Húmedo Seco 

Ciudad de Tacna 
Enero, febrero, marzo, abril, mayo, 

noviembre y diciembre. 

Junio, julio, agosto, 

septiembre, octubre. 



Página 42 

 

 

Tabla 9  

Tacna: Población censada entre el año 2007 y 2017 

Fuente: INEI - Censos Nacionales 2017: XII de Población, VII de Vivienda y III de Comunidades Indígenas. 
 

d. Información de estructuras urbanas  

La ciudad de Tacna en sus estructuras urbanas utiliza los materiales de construcción; 

ladrillo, cemento, adobe, madera y tejas para la urbanización. 

 

Provincia y distrito 
2007 2017 

Población % Población % 

Distrito Tacna 94428 35.94 92972 30.35 

Distrito Alto De La Alianza 35439 13.49 34061 11.12 

Distrito Ciudad Nueva 34231 13.03 31866 10.40 

Distrito Pocollay 17113 6.51 18627 6.08 

Distrito coronel Gregorio Albarracín Lanchipa 68989 26.26 110417 36.04 

Distrito Calana 2625 1.00 2979 0.97 
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Tabla 10 

Material de construcción predominante en las paredes exteriores de las viviendas, 

según Provincia y Distritos 

Provincia y Distritos 

Material de construcción 

Ladrillo o 
bloque de 
cemento 

Piedra o  
sillar con cal 
o cemento 

Adobe Tapia 
Quincha 

(caña con 
barro) 

Piedra 
con 

barro 

Madera 
(pona, 
tornillo, 

etc.) 

Triplay / 
calamina / 

estera 

Otro 
material 

1/ 

Distrito Tacna 105 375 625 4 936 23 297 92 1 019 1 330 0 

Distrito Alto De La Alianza 33 648 202 326 0 37 28 1 229 2 464 0 

Distrito Calana 2 514 31 741 13 21 9 195 194 0 

Distrito Ciudad Nueva 36 877 126 152 5 31 6 1 161 1 964 0 

Distrito Pocollay 19 197 70 866 0 46 36 415 1 671 0 

Distrito Crnl. Gregorio 
Albarracín Lanchipa 133 254 621 1 236 25 142 42 1 669 6 521 0 

Fuente: INEI - Censos Nacionales 2017: XII de Población, VII de Vivienda y III de Comunidades Indígenas.  
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Tabla 11 

Material de construcción predominante en los techos de las viviendas, según 

provincia y distrito de Tacna 

Fuente: INEI - Censos Nacionales 2017: XII de Población, VII de Vivienda y III de Comunidades Indígenas.  

Provincia y Distritos 

Material de construcción 

Concreto armado Madera Tejas 

Planchas de 
calamina, fibra 
de cemento o 
similares 

Caña o estera 
con torta de 
barro o 
cemento 

Triplay / 
estera / 
carrizo 

Paja, hoja 
de 
palmera y 
similares 

Otro 
materi
al 
1/ 

Distrito Tacna 87256 1258 787 21013 2196 1114 70 3 

Distrito Alto De La 
Alianza 27766 246 192 8556 358 811 5 0 

Distrito Calana 990 100 35 1912 572 106 3 0 

Distrito Ciudad Nueva 30660 303 177 8015 455 699 13 0 

Distrito Pocollay 14242 205 96 6588 586 551 33 0 

Distrito Crnl. Gregorio 
Albarracín Lanchipa 71494 871 531 65735 2219 2590 70 0 
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e. Información de las características térmicas de los materiales de construcción 

• Conductividad térmica (λ): Capacidad del material para transmitir el calor de 

su masa. 

• Densidad (ρ): Relación entre la masa y el volumen de cualquier cuerpo 

material.  

• Calor específico (Cp): Cantidad de calor del material para aumentar o 

disminuir su temperatura a °C 

• Calor específico volumétrico (ρCp): Capacidad de almacenamiento de calor 

de un determinado material o su capacidad volumétrica.  

• Difusividad térmica (a): Capacidad de un material para transmitir la 

temperatura. 

• Efusividad térmica (b): Capacidad de un material para absorber o restituir 

un flujo de calor o potencia térmica.  

Para determinar la capacidad de almacenamiento de calor y su capacidad de 

transmisión de temperatura, se realiza las siguientes formulas:  

• Difusividad térmica (a) 

a=λ/ρCp 

Donde 

a: Difusividad térmica  

λ: Conductividad térmica 

ρCp: Calor específico volumétrico 

 

• Efusividad térmica (b) 

b = (λρCp) ½ 

Donde 

b: Efusividad térmica 

λ: Conductividad térmica 

ρCp: Calor específico volumétrico 
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 Tabla 12 

Lista de materiales y sus propiedades térmicas a temperatura ambiente. 

Fuente: (Gonzales , 2014) 

3.7.2. Procesamiento de imágenes satelitales 
Antes de procesar las imágenes satelitales, se deben corregir radiométricamente 

para minimizar los errores en su procesamiento y análisis. 

a. Corrección Radiométrica  

Implica la restauración de líneas o píxeles perdidos y la corrección del bandeado de 

la imagen. 

• Corrector de Escaneo Lineal (SLC) en Landsat 7 ETM+. 

 

 

 

 

 

 

 

 

 
Fuente: Elaboración propia. 

MATERIAL λ ρ Cp a b 

 W/Mk kg/m3 J/kgK m²/s J/m²Ks½ 

Madera de construcción 0.130 630 1360 1.52E-07 3.34E+02 

Tierra con paja 0.300 400 900 8.33E-07 3.29E+02 

Agua 0.582 1000 4187 1.39E-07 1.56E+03 

Ladrillos de arcilla 0.814 1800 921 4.91E-07 1.16E+03 

Vidrio plano 1.160 2490 830 5.61E-07 1.55E+03 

Concreto pesado 1.750 2300 920 8.27E-07 1.92E+03 

Figura 7.Imagen con Gaps e imagen corregida. 
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Fuente: Elaboración propia. 

• Corrección del bandeado  

Se realiza la corrección debido a las interferencias que fueron causados por las 

condiciones atmosféricas y de iluminación al instante que los sensores adquieren las 

imágenes.  Por ello con el uso del Software ENVI Classic y la Herramienta de “Calibración 

Landsat”, va permitir minimizar las interferencias atmosféricas donde introduce los 

siguientes datos: Tipo de satélite Landsat, fecha, elevación solar, altura promedio del área, 

tipo de banda adquirida y tipos de calibración (de Radiancia a Reflectancia)  

CORRECTOR DE 
ESCANEO LINEAL

ENVI Classic 5.0

Paso 1: Corregir 
bandas

Basic 
Tools>Preprocessing>
Data-Specific Utilities> 
Landsat TM> Landsat 

Gapfill

Landsat 7 
(B1 al B7)

Figura 8.Diagrama del Corrector de Escaneo Lineal (SLC) 
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Fuente: Elaboración propia. 
 

 

 

 

 

 

CORRECTOR DE 
BANDEADO

ENVI Classic 5.0

Paso 1: Calibrar Landsat

Basic Tools > Preprocesing 
> Data-Specific Utilities > 

Landsat TM > Landsat 
Calibration

De Radiancia a Reflectancia

Paso 2: Guardar en formato 
TIFF

Landsat 5-7
(B3 y B4)

Figura 9.Diagrama de la corrección del bandeado 
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 Tabla 13 

Datos extraídos de la Metadata de Landsat 5-7 para su calibración 

Fuente: Elaboración propia. 

b. Composición de bandas Landsat 5- 7  

La composición de bandas de los Landsat 5-7, permite combinar las bandas entre 

sí para generar imágenes de color verdadero o de color falso con la combinación de bandas, 

donde se aplica a cada uno de los tres colores primarios (rojo, verde, azul).  A continuación, 

se describe los pasos para la composición de bandas en Landsat 5-7 (Ver Figura 10) para 

cada cuadricula 072 y 073. 

 

 

 

 

 

Periodo húmedo 

Fecha Landsat Sensor SUN_ELEVATION 
002-072 002-073 

28/03/1985 

5 

TM 47.16604768 46.3525168 
24/03/1995 TM 43.16005137 42.47805001 
19/03/2005 TM 51.86883637 51.09629720 
13/02/2010 TM 55.73742584 55.44905413 
8/04/2015 7 ETM 51.37254681 50.31743065 

31/12/2019 ETM 56.80505924 43.46605358 
Periodo seco 

21/07/1986 

5 

TM 35.18575054 34.05990081 
2/10/1995 TM 46.95985321 46.39430347 

26/08/2005 TM 47.32324949 46.26306933 
7/07/2010 TM 38.63154141 37.39182558 

15/09/2015 7 ETM 55.43953287 54.45180055 
12/10/2019 ETM 59.21644162 58.60769017 
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Fuente: Elaboración propia. 

c. Mosaico de las cuadriculas  

• Corte de las imágenes satelitales.  

Se inserta las composiciones de bandas de cada fecha adquirida y los elementos 

de corte (072 y 073). Se sigue con la siguiente extensión (Arctoolbox > Spatial Analysis 
Tool > Extraction > Extract by Mask). Guardar con el nombre “Corte_72” y “Corte_73” 

 

COMPOSICION DE 
BANDAS

ENVI Classic 5.0

Paso 1: Generar Archivo 
Nuevo

File > Save File as > ENVI 
Standard

Paso 2: Inportar bandas 
seleccionadas

Reordenar de manera 
ascendente y Exportar

Paso 3: Guardar en 
formato TIFF

File > Save File as >  
TIFF/Geo TIFF

Landsat 5-7
(B1 ; B2; B3; B4;B5;B7)

Figura 10.Diagrama de Composición de Bandas. 
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Fuente: Elaboración propia. 

 
Figura 12.Modelamiento de corte de imagen satelital (ArcGis) 
Fuente: Elaboración propia. 
 

 

 

 

 

CORTE DE 
IMÁGENES 

SATELITALES

ArcGis (ArcMap)

Paso 1: Cortar

Ir: Arc toolbox > 
Spatial Analysis 

Tool > Extraction > 
Extract by Mask

Landsat 5-7
(Composición de 

Bandas  y los 
elementos de corte)

Figura 11.Diagrama de corte de Imágenes Satelitales 
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• Unión de las imágenes satelitales  

Para realizar la unión los cortes (072 y 073) se efectúa con el uso de dos programas:  

- Unión de Raster en ArcGis 

Se utiliza la herramienta “Mosaic To New Raster”, se agrega los cortes o bandas por 

separado del Landsat 5-7 y se sigue la siguiente extensión (Arctoolbox > Data 
Management Tool > Raster > Raster Dataset > Mosaic To New Raster). 

Ventana de Mosaico: 
 

 Ráster de entrada: Corte_73 - Corte_72  

 Ráster de salida: Carpeta de destino Spatial 

 Referencia espacial para ráster: 19 K 

 Numero de Bandas: Depende de su selección 

 

- Unión de Raster en ENVI Classic 

Utilizando la herramienta “Georeferenced” y se realiza la siguiente extensión (Basic 
Tools > Mosaicking > Georeferenced). 
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Fuente: Elaboración propia. 

UNIÓN DE LAS 
IMÁGENES 

SATELITALES 

ArcGis (ArcMap)

Paso 1: Crear nuevo 
mosaico

Arctoolbox > Data 
Management Tool > 

Raster > Raster Dataset > 
Mosaic To New Raster

ENVI Classic 5.0

Paso 1: Georreferenciar

Basic Tools > Mosaicking 
> Georeferenced

Paso 2: Inportar TIFF a 
elección

Inport > Inport Files

Paso 3: Editar entrada

Para las dos cuadriculas:
Clic derecho > Edit Entry 
> Data value To ingore  = 

0 

Paso 4: Aplicar

File > Apply 

Paso 5: Guardar en 
formato TIFF

File > Save File as >  
TIFF/Geo TIFF

Landsat 5-7
Bandas por  las dos 

cuadricula

Figura 13.Diagrama de Unión de las Imágenes Satelitales 
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Figura 14.Modelamiento de unión de imagen satelital.(ArcGis) 
Fuente: Elaboración propia. 

• Corte en la zona de estudio 

Para realizar el corte de nuestra zona de estudio se efectúa con el uso de dos 

programas:  

- Corte en ArcGis 

Se utiliza la herramienta “Extract by Mask”, se agrega el Raster de imagen satelital 

y shp de la zona urbana de Tacna y se sigue la siguiente extensión (Arctoolbox > Spatial 
Analysis Tool/Extraction > Extract by Mask).  

Ventana de extracción de mascara: 

 Ráster de entrada: Unión.shp 

 Ingreso de datos de máscara de entidad o ráster: Limite departamental o 

zona urbana.shp 

 

- Corte en ENVI Classic 

Utilizando la herramienta “Spatial Subset” y se realiza la siguiente extensión (File > 
Save File as > ENVI Standard > Spatial Subset) y guardar con el nombre “Unión” 
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Tabla 14 

Coordenadas  para corte de Imagen Satelital. 

 

 
 
 
 
 

Fuente: Elaboración propia. 
 

 

Fuente: Elaboración propia. 
 

CORTE EN LA ZONA 
DE ESTUDIO

ArcGis (ArcMap)

Paso 1: Corte

Ir: Arc toolbox > Spatial 
Analysis Tool > Extraction > 

Extract by Mask

ENVI Classic 5.0

Paso 1: Seleccionar espacio 
de corte

File > Save File as > ENVI 
Standard >Spatial Subset> 

Map

Paso 2: Insertar 
coordenadas de corte

Añadir las coordendas de la 
Tabla 14

Paso 3: Guardar en formato 
TIFF

File > Save File as >  
TIFF/Geo TIFF

Landsat 5-7
Bandas unidas

shp: Limite Deparmental
Zona Urbana de taca

Coordenadas Superior Inferior 

Este 359535 385455 

Norte 8025925 7997275 

Figura 15. Diagrama de Corte de zona de estudio 
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Figura 16.Modelamiento de corte en la zona de estudio(ArcGis) 
Fuente: Elaboración propia. 

3.7.3. Procesamiento de NDVI 
NDVI ayuda a identificar lugares con vegetación y cuán vigorosa es la misma. En 

primer lugar, se realiza los ajustes de bandas espectrales (corte de bandas y unión de 

bandas). El cálculo del NDVI se realizó a cada una de las 12 imágenes. Para el cálculo del 

NDVI se realizó con los softwares; ArcGis y ENVI Classic para su posterior comparación de 

datos.  

• NDVI en ArcGis 

Se utiliza la herramienta “Calculadora Raster”, se añade los archivos “B3” y “B4” 

previamente unidos, donde se realiza la siguiente extensión (Arctoolbox >Spatial 
Analysis Tool> Map Algebra> Raster Calculator) cuya fórmula es (Float (B4 - B3)) / 
(Float (B4 + B3)) y se guarda.   

• NDVI en ENVI Classic 

Utilizando la herramienta “Band Math”, se añade los archivos “B3” y “B4” 

previamente unidos y se realiza la siguiente extensión (Basic Tools > Band Math), la 

ecuación es (B4 –B3) / (B4 +B3) y se guarda. 
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Figura 17. Diagrama de NDVI 
Fuente: Elaboración propia. 

• Corte del NDVI en la zona de estudio 

El procedimiento del corte del NDVI se realiza con los dos resultados del programa 

ArcGis (ArcMap) y ENVI Classic 5.0 donde se muestra en el ítem 3.2.2. (c), corte área y/o 

zona de estudio. 

a. Clasificación del NDVI  

Para realizar la clasificación (Tabla 15) se utiliza la herramienta “Reclasificar” del 

software ArcGis (ArcMap), se realiza la siguiente extensión (Arctoolbox >Spatial Analysis 
Tool> Reclass > Reclassify)) y se guarda. 

 será clasificado por 3 rangos de a continuación: 

Ventana de reclasificación: 

 Método de clasificación: igual Interval 

UNIÓN DE LAS 
IMÁGENES 

SATELITALES 

ArcGis (ArcMap)

Paso 1: Crear 
Ecuación

Arctoolbox >Spatial 
Analysis Tool> Map 

Algebra> Raster 
Calculator

(Float (B4 - B3)) / 
(Float (B4 + B3)) 

ENVI Classic 5.0

Paso 1: Crear 
ecuación

Basic Tools > Band 
Math

(B4 –B3) / (B4 +B3)

Paso 2: Definir 
variables

Reemplazar: Los Shp
(B_3 y B_4) con las 

variables de la 
ecuación 

Paso 3: Exportar

Formato TIFF

Landsat 5-7
Bandas (B3 , B4)
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 Clases: 3 

 Valores: Se utiliza el valor mínimo y máximo de cada fecha de adquisición 

Tabla 15 

Rangos de NDVI 
NDVI Descripción  

NDVI<0.2  Suelo urbano 

0.2 ≤NDVI ≤ 0.5 Vegetación y suelo urbano 

NDVI>0.5 Vegetación arbustiva 
Fuente: (Soberón & Obregón, 2015) 
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Fuente: Elaboración propia. 
 

CLASIFICACCIÓN DE 
NDVI

Raster : NDVI
(Por ArcMap y ENVI 

Classic)

Paso 1: Crear 
Reclassificación

(Raster)

Ir: Arctoolbox >Spatial 
Analysis Tool> Reclass 

> Reclassify

Minimo < 0.2 < Maximo

Guardar: Reclas

Paso 2: Transformar 
Raster a Poligono

Seleccionar: Reclas
Ir: Arctoolbox 

>Conversion Tools > 
From Raster> Raster to 

Polygon

Guardar: Reclas_NDVI

Figura 18.Diagrama de clasificación del NDVI 
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Figura 19.Modelamiento del NDVI (ArcGis) 
Fuente: Elaboración propia. 

3.7.4. Procesamiento de temperatura 
Luego de realizar el pre- procesamiento de las imágenes satelitales, el NDVI, la 

reclasificación y obtener la vegetación sana de los distritos de la ciudad urbana de 

Tacna. Con el software ArcGis se utiliza la herramienta “Calculadora Raster”, 

a. Convertir de ND a Radiancia 

Con el programa ArcMap, se añade los archivos “B6” previamente unidos, donde se 

realiza la siguiente extensión (Arctoolbox >Spatial Analysis Tool> Map Algebra> Raster 
Calculator) cuya ecuación es ((LMAXλ - LMINλ) / (QCALMAX - QCALMIN)) * (QCAL - 
QCALMIN) + LMINλ y se guarda con el nombre “RADIANCIA”.  

En la siguiente tabla se visualiza los datos extraídos por la meta data de los sensores 

Landsat 5 – 7: 

Tabla 16 

Metadata de los sensores Landsat 5-7 para la conversión de ND a radiancia 

 Fuente: Elaboración Propia 
 

Sensor QCAL LMAXλ LMINλ QCALMAX QCALMIN 

Landsat 5 Banda 6 15.303 1.238 255 1 

Landsat 7 Banda 6_ VCID_2 12.650 3.200 255 1 
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b. Convertir Radiancia a Temperatura en grados Kelvin 

Con el programa ArcMap, se añade los archivos “Radiancia” se realiza la siguiente 

extensión (Arctoolbox >Spatial Analysis Tool> Map Algebra> Raster Calculator) y se 

realiza la siguiente ecuación K2/ Ln (K1/ Radiancia + 1) y se guarda con el nombre 

“Temp_Kelvin”.   

Tabla 17 

Constantes de calibración K1 y K2 

Fuente: Elaboración Propia. 
 

c. Convertir Temperatura de grados Kelvin a grados Celsius 

Con el programa ArcMap, se añade los archivos “Temp_Kelvin” se realiza la 

siguiente extensión (Arctoolbox >Spatial Analysis Tool> Map Algebra> Raster 
Calculator) y se realiza la siguiente ecuación Tem_K – 273.15 y se guarda con el nombre 

“Temp_Celsius”.   

Sensor Constante 1 - K1 
(Watts/(m2*sr*μm)) Constante 2 – K2 (Kelvin) 

Landsat 7 ETM+ 666.09 1282.71 
Landsat 5 TM 607.76 1260.56 
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Figura 20.Diagrama de Temperatura Superficial Terrestre(TST) 
Fuente: Elaboración Propia. 

 

 
Figura 21.Modelamiento del TST (ArcGis) 
Fuente: Elaboración propia. 
 

 

TST

Raster:Banda 6

Paso 1: Convertir de 
ND a Radiancia

Ir:Arctoolbox >Spatial 
Analysis Tool> Map 

Algebra> Raster 
Calculator

𝐿𝐿𝜆𝜆
=

𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝜆𝜆 − 𝐿𝐿𝐿𝐿𝑁𝑁𝑁𝑁𝜆𝜆
𝑄𝑄𝑄𝑄𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿 − 𝑄𝑄𝑄𝑄𝐿𝐿𝐿𝐿𝐿𝐿𝑁𝑁𝑁𝑁

∗ 𝑄𝑄𝑄𝑄𝐿𝐿𝐿𝐿 − 𝑄𝑄𝑄𝑄𝐿𝐿𝐿𝐿𝐿𝐿𝑁𝑁𝑁𝑁
+ 𝐿𝐿𝐿𝐿𝑁𝑁𝑁𝑁𝜆𝜆

Paso 2: Convertir de 
radiancia a 

Temperatura °K

Ir:Arctoolbox >Spatial 
Analysis Tool> Map 

Algebra> Raster 
Calculator

T =
K2

ln (K1
Lλ

+ 1)

Paso 3: Convertir 
Temperatura de °K a 

°C

Ir:Arctoolbox >Spatial 
Analysis Tool> Map 

Algebra> Raster 
Calculator

𝑄𝑄 = 𝐾𝐾 − 273.15
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3.7.5. Correlación de temperatura y NDVI 
Para realizar la correlación se selecciona dos variables: NDVI y Temperatura, se 

ejecuta los siguientes procedimientos:  

a. Crear grillas en base la zona urbana 

Con el programa ArcMap, se utiliza la herramienta “Create Fishnet “para crear 

polígonos y puntos en la extensión de la zona urbana de Tacna, donde se añade los Raster 

(NDVI, TST) y el shp. zona urbana de Tacna, se realiza la siguiente extensión (Arctoolbox 
>Data Management Tools > Sampling > Create Fishnet). 

Ventana de creación de grilla: 

 Clase de entidad de salida: Escribir “NDVI_TST”  

 Extensión de la plantilla: Zona urbana de Tacna 

 Número de filas y columnas: 50 

 Tipo de geometría: Polígono 

b. Registrar valores en la tabla de atributos   

Para el siguiente procedimiento se utiliza la herramienta “Extrac Multi Values To 

Points” para registrar los valores en la tabla de atributos del shp. “NDVI_TST” con un 

sufijo _label donde se realiza la siguiente extensión (Arctoolbox > Spatial Analysis 
Tool/Extraction > Extrac Multi Values To Points). 

Ventana de extracción de valores múltiples a puntos: 

 Características del punto de entrada: NDVI_TST_label 

 Rásteres de entrada: Añadir rasteres (NDVI y TST) 

c. Cortar en la zona de estudio 

Para el siguiente procedimiento se utiliza la herramienta “Clip” para cortar el shp. 

“NDVI_TST” con un sufijo _label en nuestra zona urbana (Arctoolbox > Analysis Tools > 
Extract > Clip) y guardar con el nombre de “Correlación” 

Rellenar Ventana de corte: 

 En características de entrada: Shp. NDVI_TST_label 

 En zona de corte: Zona_Urbana 
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Figura 22.Modelamiento de la correlación NDVI y  TST (ArcGis) 
Fuente: Elaboración propia. 
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Figura 23. Diagrama de Correlación entre NDVI y TST 
Fuente: Elaboración propia. 

 

 

 

CORRELACIÓN DEL 
ÍNDICE DE NDVI Y 

TST

Shp: Zona urbana de 
Tacna

Rasteres: NDVI (de 
ArcMap) y TST 

Paso 1: Crear grillas 

Ir:Arctoolbox >Data 
Management Tools > 
Sampling > Create 

Fishnet. 

Guardar: NDVI_TST

Paso 2: Registrar 
valores en la tabla de 

atributos en 
"NDVI_TST"

Ir: Arctoolbox > Spatial 
Analysis 

Tool/Extraction > 
Extrac Multi Values To 

Points

Paso 3: Cortar en la 
zona de estudio

Ir:Arctoolbox > Analysis 
Tools > Extract > Clip

Guardar: Correlación
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Figura 24.Diagrama para el procesamiento de la información. 
Fuente: Elaboración propia. 

SELECCION DE 
ZONA DE 
ESTUDIO

Pre- procesamiento

Imagenes 
satelitales

Crrección 
radiométrica

Corrector de 
Escaneo Lineal 

(SLC) en Landsat 
7 ETM+

Corrector del 
bandeado 

Composición de 
bandas Landsat 

5- 7 
Mosaico de 
cuadriculas

Corte de 
imagenes 
satelitales

Unión de 
imagenes 
satelitales

Corte de zona de 
estudio

Procesamiento para 
hallar la TST

Calculo de NDVI

Conversión de ND a 
Radiancia

Convertir de 
radiancia a 

Temperatura °K

Convertir 
Temperatura de °K 

a °C

Obtencion de 
imagenes 
satelitales
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Fuente: Elaboración propia. 

 

 

 

 

 

Landsat 5-7  

Reclasificación de NDVI 

Calculo NDVI (B3 y B4) 

𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁 =  
𝐵𝐵4 − 𝐵𝐵3
𝐵𝐵4 + 𝐵𝐵3

 

Mínimo<0.2 < Máximo 

Imagen Termal (B6) 

Conversión de ND a 
Radiancia 

𝐿𝐿𝜆𝜆

=
𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝜆𝜆 − 𝐿𝐿𝐿𝐿𝑁𝑁𝑁𝑁𝜆𝜆

𝑄𝑄𝑄𝑄𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿 − 𝑄𝑄𝑄𝑄𝐿𝐿𝐿𝐿𝐿𝐿𝑁𝑁𝑁𝑁

∗ (𝑄𝑄𝑄𝑄𝐿𝐿𝐿𝐿 − 𝑄𝑄𝑄𝑄𝐿𝐿𝐿𝐿𝐿𝐿𝑁𝑁𝑁𝑁) 

Cobertura Vegetal 

Área: Km2 

Gridcode 3 

Convertir de radiancia a 
Temperatura °K 

𝑇𝑇 =
𝐾𝐾2

𝑙𝑙𝐵𝐵 (𝐾𝐾1
𝐿𝐿𝜆𝜆

+ 1)
 

Convertir Temperatura de 
°K a °C 

𝑄𝑄 = 𝐾𝐾 − 273.15  

Figura 25.Diagrama de cálculo del NDVI y TST con Imágenes Landsat 5 – 7 
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CAPÍTULO IV: 
RESULTADOS 

4.1. Procesamiento de imágenes satelitales 
4.1.1. Periodo húmedo  

Tabla 18 

Información en Landsat 5 (Periodo Húmedo) 
002-072 

Fecha  Landsat Sensor Id Datum UTM 

28/03/1985 L5 TM 
LT05_L1TP_002072_19
850328_20170219_01_
T1 

WGS84 19 

24/03/1995 L5 TM 
LT05_L1TP_002072_19
950324_20170108_01_
T1 

WGS84 19 

19/03/2005 L5 TM 
LT05_L1TP_002072_20
050319_20161128_01_
T1 

WGS84 19 

13/02/2010 L5 TM 
LT05_L1TP_002072_20
100213_20161016_01_
T1 

WGS84 19 

002-073 

28/03/1985 L5 TM 
LT05_L1TP_002073_19
850328_20170219_01_
T1 

WGS84 19 

24/03/1995 L5 TM 
LT05_L1TP_002073_19
950324_20170108_01_
T1 

WGS84 19 

19/03/2005 L5 TM 
LT05_L1TP_002073_20
050319_20161126_01_
T1 

WGS84 19 

13/02/2010 L5 TM 
LT05_L1TP_002073_20
100213_20161019_01_
T1 

WGS84 19 

Fuente: Elaboración propia. 
 

Tabla 19  

Información en Landsat 7 (Periodo Húmedo) 
002-072 

Fecha Landsat Sensor Id Datum UTM 

8/04/2015 L7 ETM 
LE07_L1TP_002072_
20150408_20161027_
01_T1 

WGS84 19 

31/12/2019 L7 ETM 
LE07_L1TP_002072_
20191231_20200126_
01_T1 

WGS84 19 

002-073 

8/04/2015 L7 ETM 
LE07_L1TP_002073_
20150408_20161029_
01_T1 

WGS8
4 19 
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31/12/2019 L7 ETM 
LE07_L1TP_002073_
20191231_20200126_
01_T1 

WGS84 19 

Fuente: Elaboración propia. 

4.1.2. Periodo Seco 

Tabla 20 

Información en Landsat 5 (Periodo Seco) 

002-072 

FECHA  LANDSAT SENSOR ID DATUM UTM 

21/07/1986 L5 TM 
LT05_L1TP_002072_19
860721_20170217_01_T
1 

WGS84 19 

2/10/1995 L5 TM 
LT05_L1TP_002072_19
951002_20170106_01_T
1 

WGS84 19 

26/08/2005 L5 TM 
LT05_L1TP_002072_20
050826_20161124_01_T
1 

WGS84 19 

7/07/2010 L5 TM 
LT05_L1TP_002072_20
100707_20161014_01_T
1 

WGS84 19 

002-073 

21/08/1986 L5 TM 
LT05_L1TP_002073_19
860721_20170217_01_T
1 

WGS84 19 

2/10/1995 L5 TM 
LT05_L1TP_002073_19
951002_20170106_01_T
1 

WGS84 19 

26/08/2005 L5 TM 
LT05_L1TP_002073_20
050826_20161124_01_T
1 

WGS84 19 

7/07/2010 L5 TM 
LT05_L1TP_002073_20
100707_20161014_01_T
1 

WGS84 19 

Fuente: Elaboración propia. 
 

Tabla 21  

Información en Landsat 7 (Periodo Seco) 
002-072 

FECHA LANDSAT SENSOR ID DATUM UTM 

8/04/2015 L7 ETM 
LE07_L1TP_002072_20
150915_20161020_01_
T1 

WGS84 19 

12/10/2019 L7 ETM 
LE07_L1TP_002072_20
191012_20191107_01_
T1 

WGS84 19 

002-073 
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8/04/2015 L7 ETM 
LE07_L1TP_002073_20
150915_20161020_01_
T1 

WGS84 19 

12/10/2019 L7 ETM 
LE07_L1TP_002073_20
191012_20191107_01_
T1 

WGS84 19 

Fuente: Elaboración propia. 

4.2. Procesamiento de NDVI 
Los resultados con el sotware ENVI Classic y ArcMap tienen las mismas variaciones 

y queda demostrado que es un dato real. Al momento de realizar la clasificación se analiza 

los rangos y se adquiere la vegetación cuyo rango es; mayor de 0.2. En las siguientes tablas 

se estiman la superficie total y el porcentaje de cada periodo en relación a los años.   

4.2.1. Periodo Húmedo 
Tabla 22 

Estimación de superficie y porcentaje en la vegetación sana (Periodo Húmedo) 

 Superficie (km2) / Porcentaje 
Año Área % 
1985 2.537 100 
1995 1.111 43.8 
2005 1.106 43.6 
2010 0.838 33 
2015 0.130 5 
2019 0.240 9 

Fuente: Elaboración propia. 
 

 
Gráfico 1.Estimación de superficie en la vegetación sana (Periodo Húmedo) 
Fuente: Elaboración propia. 

2.510859

1.061122 1.008449
0.783305

0.123823 0.231574

28/03/1985 24/03/1995 19/03/2005 13/02/2010 8/04/2015 31/12/2019
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Mapa 1 

NDVI entre el año 1985 y 2019 (Periodo Húmedo) 

 

Fuente: Elaboración propia. 



Página 72 

 

 

4.2.2. Periodo Seco 

Tabla 23  

Estimación de superficie y porcentaje en la vegetación sana (Periodo Seco) 

 Superficie (km2) / Porcentaje 

Año Área % 

1986 3.954 
 

100 

1995 2.938 74 

2005 2.457 62 

2010 1.294 33 

2015 0.506 13 

2019 0.382 10 
Fuente: Elaboración propia. 

 

 
Gráfico 2. Estimación de superficie en la vegetación sana (Periodo Seco) 
Fuente: Elaboración propia. 

 

 

3.964817

2.791141
2.311022

1.188424

0.501393 0.367226

21/07/1986 2/10/1995 26/08/2005 7/07/2010 15/09/2015 12/10/2019
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Mapa 2 

NDVI entre el año 1986 y 2019(Periodo Seco) 

 
Fuente: Elaboración propia. 
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4.3. Procesamiento de temperatura  
4.3.1. Temperatura atmosférica y superficial 

En las siguientes tablas de ambos periodos, se da a conocer la diferencia entre la 

temperatura del aire o ambiente (SENAMHI) es la sensación térmica (frio o calor) y la 

superficial es la energía que absorbe en la tierra. 

Tabla 24  

Diferencia de temperatura ambiental y superficial (Periodo Húmedo) 

 

 

 

 
 
 
 
 
 
 

Fuente: Elaboración propia. 
 

Tabla 25  

Diferencia de temperatura ambiental y superficial (Periodo Seco) 

Año Mes 

Temperatura (°C) aire/superficial 

Ta(mensual) Ts 
Tmax Tmin Tmax Tmin 

1986 JUL - - 29.1 16.56 

1995 OCT 23.1 12.61 35.65 11.88 
2005 AGO 19.8 10.05 36.04 21.5 
2010 JUL 17.73 8.09 30 7.5 
2015 NOV 22.7 14.72 42.80 23.6 
/2019 OCT 22.36 11.97 42.64 23.6 

Fuente: Elaboración propia. 
 

La capacidad de almacenamiento de calor, y la capacidad de transmitir la 

temperatura en un determinado material; ladrillos, cemento, adobe, madera y tejas; 

cumplen con la relación de la temperatura superficial (Tabla 13).  Las tablas siguientes 

demuestran que al pasar de los años comienza a aumentar las temperaturas; mayores de 

30°C.  

 

Año Mes 

Temperatura (°C) aire/superficial 
Ta(mensual) Ts 

Tmax Tmin Tmax Tmin 

1985 MAR - - 32.45 21.5 
1995 MAR 27.16 16.62 29 18.83 
2005 MAR 26.72 15.81 36 23.25 
2010 FEB 29.09 17.1 32.4 15.64 
2015 ABR 25.86 16.56 33.8 23.25 
2019 DIC 26.84 16.3 40.5 24.8 
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4.3.2. Periodo Húmedo 

Tabla 26 

Estimación de la clasificación y superficie de la temperatura en el año 1985 

(Periodo Húmedo) 

 Clasificación /Superficie (km2) 
GRID Temperatura Área 

1 21.50268555 - 22.79133516 0.233 
2 22.79133517 - 23 0.297 
3 23.00000001 - 24 1.853 
4 24.00000001 - 25 4.126 
5 25.00000001 - 25.7 3.058 
6 25.70000001 - 26 3.358 
7 26.00000001 - 27 5.867 
8 27.00000001 - 28 7.996 
9 28.00000001 - 29 13.193 

10 29.00000001 - 30 19.949 
11 30.00000001 - 30.8 10.436 
12 30.80000001 - 32.45620728 1.8471 

A partir de la GRID 12 es >30°C** 
Fuente: Elaboración propia. 

 

Tabla 27 

Estimación de la clasificación y superficie de la temperatura en el año 1995 

(Periodo Húmedo) 

 Clasificación /Superficie (km2) 
GRID Temperatura Área 

1 18.83358765 - 19.72650565 0.165 
2 19.72650566 - 20 0.316 
3 20.00000001 - 21 1.711 
4 21.00000001 - 21.9 5.608 
5 21.90000001 - 22 3.875 
6 22.00000001 - 23 6.940 
7 23.00000001 - 24 6.779 
8 24.00000001 - 25 13.704 
9 25.00000001 - 26 7.936 

10 26.00000001 - 26.6 3.135 
11 26.60000001 - 27 6.438 
12 27.00000001 - 29.18331909 15.593 

No hay temperatura >30°C 
Fuente: Elaboración propia. 
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Tabla 28 

Estimación de la clasificación y superficie de la temperatura en el año 2005 

(Periodo Húmedo) 

 Clasificación /Superficie (km2) 
GRID Temperatura Área 

1 23.25027466 - 24.50475955 0.068 
2 24.50475956 - 25 0.410 
3 25.00000001 - 26 1.591 
4 26.00000001 - 27 4.661 
5 27.00000001 - 27.9 9.033 
6 27.90000001 - 29 11.476 
7 29.00000001 - 30 5.654 
8 30.00000001 - 31 9.894 
9 31.00000001 - 32 7.299 

10 32.00000001 - 32.8 10.045 
11 32.80000001 - 33 4.258 
12 33.00000001 - 36.04602051 7.802 

A partir del GRID 9 al 12 es >30°C 
Fuente: Elaboración propia. 

 

Tabla 29 

Estimación de la clasificación y superficie de la temperatura en el año 2010 

(Periodo Húmedo) 

 Clasificación /Superficie (km2) 
GRID Temperatura Área 

1 15.64254761 - 16.96126601 0.064 
2 16.96126602 - 18 0.107 
3 18.00000001 - 20 0.263 
4 20.00000001 - 22 1.424 
5 22.00000001 - 23 2.124 
6 23.00000001 - 24 5.442 
7 24.00000001 - 25 17.081 
8 25.00000001 - 26 10.111 
9 26.00000001 - 27 7.069 

10 27.00000001 - 28 10.380 
11 28.00000001 - 29 6.451 
12 29.00000001 - 32.45620728 11.699 

A partir de la GRID 12 es >30°C 
Fuente: Elaboración propia. 

 



Página 77 

 

 

Tabla 30 

Estimación de la clasificación y superficie de la temperatura en el año 2015 

(Periodo Húmedo) 

 Clasificación /Superficie (km2) 
GRID Temperatura Área 

1 19.60269165 - 21.27930226 0.035 
2 21.27930227 - 23 0.077 
3 23.00000001 - 24 0.290 
4 24.00000001 - 25 1.055 
5 25.00000001 - 26 10.715 
6 26.00000001 - 26.9 10.842 
7 26.90000001 - 27 2.946 
8 27.00000001 - 28 10.034 
9 28.00000001 - 29 11.291 

10 29.00000001 - 30 11.061 
11 30.00000001 - 31 9.159 
12 31.00000001 - 33.85388184 4.678 

A partir del GRID 12 es >30°C 
Fuente: Elaboración propia. 

 

Tabla 31 

Estimación de la clasificación y superficie de la temperatura en el año 2019 

(Periodo Húmedo) 

 Clasificación /Superficie (km2) 
GRID Temperatura Área 

1 24.80575562 - 27.82639136 0.223 
2 27.82639137 - 28 0.093 
3 28.00000001 - 29 1.230 
4 29.00000001 - 30 8.572 
5 30.00000001 - 31 11.205 
6 31.00000001 - 32 12.324 
7 32.00000001 - 33 11.602 
8 33.00000001 - 34 9.435 
9 34.00000001 - 36 11.110 

10 36.00000001 - 37 2.913 
11 37.00000001 - 38 2.256 
12 38.00000001 - 40.52539063 1.227 

A partir del GRID 6 al 12 es >30°C 
Fuente: Elaboración propia. 
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Mapa 3 

TST entre el año 1985 y 2019 {Periodo Húmedo)  

 
Fuente: Elaboración propia. 
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4.3.3. Periodo Seco 

Tabla 32 

Estimación de la clasificación y superficie de la temperatura en el año 1986 

(Periodo Seco) 

 Clasificación /Superficie (km2) 
GRID Temperatura Área 

1 16.56311035 - 17.9033026 0.669 
2 17.9033026-18 1.271 
3 18.00000001 - 19 5.557 
4 19.00000001 - 21 12.706 
5 20.00000001 - 21.9 7.337 
6 21.90000001 - 22 4.468 
7 22.00000001 - 23 9.479 
8 23.00000001 - 24 14.246 
9 24.00000001 - 25 10.196 

10 25.00000001 - 26 4.065 
11 26.00000001 - 27 1.608 
12 27.00000001 - 29.18331909 0.594 

No hay temperatura >30°C 
Fuente: Elaboración propia. 

 

Tabla 33 

Estimación de la clasificación y superficie de la temperatura en el año 1995 

(Periodo Seco) 

 Clasificación /Superficie (km2) 
GRID Temperatura Área 

1 11.88516235 - 15.14724492 0.046 
2 15.14724493 - 17 0.125 
3 17.00000001 - 19 0.679 
4 19.00000001 - 21 1.165 
5 21.00000001 - 23 5.017 
6 23.00000001 - 24 5.333 
7 24.00000001 - 26 13.365 
8 26.00000001 - 27 5.084 
9 27.00000001 - 29 16.397 

10 29.00000001 - 30 8.657 
11 30.00000001 - 32 12.998 
12 32.00000001 - 35.65176392 3.336 

A partir del GRID 12 es >30°C 
Fuente: Elaboración propia. 
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Tabla 34 

Estimación de la clasificación y superficie de la temperatura en el año 2005 

(Periodo Seco) 

 Clasificación /Superficie (km2) 
GRID Temperatura Área 

1 21.50268555 - 23.21366613 0.155 
2 23.21366614 - 24 0.867 
3 24.00000001 - 25 7.446 
4 25.00000001 - 26 9.932 
5 26.00000001 - 27 7.503 
6 27.00000001 - 28 9.356 
7 28.00000001 - 29 5.862 
8 29.00000001 - 30 7.116 
9 30.00000001 - 31 12.950 

10 31.00000001 - 32 3.878 
11 32.00000001 - 34 5.302 
12 34.00000001 - 36.04602051 1.827 

A partir del GRID 10 al 12 es >30°C 
Fuente: Elaboración propia. 

 

Tabla 35 

Estimación de la clasificación y superficie de la temperatura en el año 2010 

(Periodo Seco) 

 Clasificación /Superficie (km2) 
GRID Temperatura Área 

1 7.502410889 - 8.914596857 1.076 
2 8.914596858 - 10 1.182 
3 10.00000001 - 12 1.734 
4 12.00000001 - 15 2.599 
5 15.00000001 - 17 1.263 
6 17.00000001 - 19 5.154 
7 19.00000001 - 20 13.478 
8 20.00000001 - 21 11.238 
9 21.00000001 - 23 16.592 

10 23.00000001 - 24 5.117 
11 24.00000001 - 26 10.006 
12 26.00000001 - 30.00912476 2.794 

A partir del GRID 12 es >30°C 
Fuente: Elaboración propia. 
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Tabla 36 

Estimación de la clasificación y superficie de la temperatura en el año 2015 

(Periodo Seco) 

 Clasificación /Superficie (km2) 
GRID Temperatura  rea 
1 23.6036377 - 27.68649974 0.203 
2 27.68649975 - 29 1.553 
3 29.00000001 - 29.8 4.796 
4 29.80000001 - 30 2.553 
5 30.00000001 - 32 18.940 
6 32.00000001 - 33 9.048 
7 33.00000001 - 35 7.560 
8 35.00000001 - 36 13.929 
9 36.00000001 - 38 3.934 
10 38.00000001 - 39 4.117 
11 39.00000001 - 40 2.171 
12 40.00000001 - 42.88381958 3.396  

A partir del GRID 6 al 12 es >30°C 
Fuente: Elaboración propia. 

 

Tabla 37 

Estimación de la clasificación y superficie de la temperatura en el año 2019 

(Periodo Seco) 

 Clasificación /Superficie (km2) 
GRID Temperatura  Área 
1 23.6036377 - 27.41104736 0.158 
2 27.41104737 - 28 0.167 
3 28.00000001 - 29 2.357 
4 29.00000001 - 30 9.581 
5 30.00000001 - 31 11.730 
6 31.00000001 - 33 17.761 
7 33.00000001 - 34 8.076 
8 34.00000001 - 35 6.839 
9 35.00000001 - 37 7.449 
10 37.00000001 - 38 2.573  
11 38.00000001 - 39 2.366  
12 39.00000001 - 42.64068604 3.139  

A partir del GRID 12 es >30°C 
Fuente: Elaboración propia. 
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Mapa 4 

TST entre el año 1986 y 2019(Periodo Seco) 

 

Fuente: Elaboración propia. 
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4.4. Análisis estadístico en la correlación lineal 
Para aplicar cualquier prueba estadística, previamente se hace una prueba 

de normalidad, para decidir si se aplica una prueba paramétrica o no paramétrica, 

o se hace transformaciones para ajustar los datos, de modo que tengan una 

distribución normal. 

Tabla 38 

Aplicación de prueba de normalidad para correlación (Periodo Húmedo) 

Pruebas de normalidad 

  
Kolmogorov-Smirnova Shapiro-Wilk 

Estadístico gl Sig Estadístico gl Sig. 

2019 
NDVI ,162 673 ,000 ,768 673 ,000 

Temperatura ,091 673 ,000 ,969 673 ,000 

2015 
NDVI ,171 673 ,000 ,799 673 ,000 
Temperatura ,081 673 ,000 ,975 673 ,000 

2010 
NDVI ,250 673 ,000 ,695 673 ,000 
Temperatura ,089 673 ,000 ,975 673 ,000 

2005 
NDVI ,235 673 ,000 ,680 673 ,000 
Temperatura ,111 673 ,000 ,954 673 ,000 

1995 
NDVI ,514 673 ,000 ,017 673 ,000 
Temperatura ,508 673 ,000 ,018 673 ,000 

1985 

NDVI ,281 673 ,000 ,650 673 ,000 

Temperatura ,198 673 ,000 ,919 673 ,000 
Fuente: Elaboración propia. 

 

Tabla 39 

Aplicación de prueba de normalidad para correlación (Periodo Seco) 

Pruebas de normalidad 

  
Kolmogorov-Smirnova Shapiro-Wilk 

Estadístico gl Sig Estadístico gl Sig. 

2019 Temperatura ,138 355 ,000 ,916 355 ,000 

2015 
NDVI ,265 355 ,000 ,652 355 ,000 
Temperatura ,094 355 ,000 ,952 355 ,000 

2010 
NDVI ,239 355 ,000 ,732 355 ,000 
Temperatura ,161 355 ,000 ,912 355 ,000 

2005 
NDVI ,281 355 ,000 ,705 355 ,000 
Temperatura ,160 355 ,000 ,917 355 ,000 
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1995 
NDVI ,307 355 ,000 ,662 355 ,000 
Temperatura ,098 355 ,000 ,976 355 ,000 

1986 
NDVI ,312 355 ,000 ,669 355 ,000 
Temperatura ,074 355 ,000 ,963 355 ,000 

 a. NDVI2019 es una constante y se ha desestimado. 
 b. Corrección de la significación de Lilliefors 

Fuente: Elaboración propia. 

• Corrección de la significación de Lilliefors 

La prueba de normalidad elegida para ambos periodos es la de 

kolmogorov-smirnovb (para mayores de 50 datos), todos los datos son altamente 

significativos (p-valor<0.05), por lo tanto, se pude afirmar que los datos no 

provienen de una distribución normal. La prueba estadística elegida será la 

correlación de spearman (Rho de Spearman) que se usa para datos que no tienen 

distribución normal. 

4.4.1. Correlación en Periodo Húmedo  
Según lo observado en las tablas, en el (año 2019), no se puede calcular 

la correlación de spearman porque una de las variables tiene datos constantes y 

al no haber variabilidad no es posible determinar la correlación. En los demás 

casos, si existe correlación altamente significativa (p-valor<0.05) 

Tabla 40 

Correlación entre NDVI y Temperatura en el año 1985 (Periodo Húmedo) 
Correlaciones 

 NDVI Temperatura 

Rho de 
Spearman 

NDVI 

Coeficiente de 
correlación 1,000 -,385** 

Sig. (bilateral) . ,000 
N 673 673 

Temperatura 

Coeficiente de 
correlación -,385** 1,000 

Sig. (bilateral) ,000 . 
N 673 673 

**. La correlación es significativa al nivel 0,01 (bilateral). 
Fuente: Elaboración propia. 
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Gráfico 3. Dispersión lineal del año 1985 (Periodo Húmedo) 
Fuente: Elaboración propia. 
 
Tabla 41 

Correlación entre NDVI y Temperatura en el año 1995(Periodo Húmedo) 
Correlaciones 

 NDVI Temperatura 

Rho de 
Spearman 

NDVI 

Coeficiente de 
correlación 1,000 -,386** 

Sig. (bilateral) . ,000 
N 674 674 

Temperatura 

Coeficiente de 
correlación -,386** 1,000 

Sig. (bilateral) ,000 . 
N 674 674 

**. La correlación es significativa al nivel 0,01 (bilateral). 
Fuente: Elaboración propia. 

 

Gráfico 4. Dispersión lineal del año 1995 (Periodo Húmedo) 

Fuente: Elaboración propia. 
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Tabla 42 

Correlación entre NDVI y Temperatura en el año 2005 (Periodo Húmedo) 
Correlaciones 

 NDVI Temperatura 

Rho de 
Spearman 

NDVI 

Coeficiente de 
correlación 1,000 -,255** 

Sig. (bilateral) . ,000 
N 673 673 

Temperatura 

Coeficiente de 
correlación -,255** 1,000 

Sig. (bilateral) ,000 . 
N 673 673 

**. La correlación es significativa al nivel 0,01 (bilateral). 
Fuente: Elaboración propia. 
 

 

 

Gráfico 5.Dispersión lineal del año 2005 (Periodo Húmedo) 
Fuente: Elaboración propia. 
 

 

Tabla 43 

Correlación entre NDVI y Temperatura en el año 2010 (Periodo Húmedo) 

y = -11.834x + 28.872
R² = 0.1090
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Correlaciones 
 NDVI Temperatura 

Rho de 
Spearman 

NDVI 

Coeficiente de 
correlación 1,000 -,120** 

Sig. (bilateral) . ,002 
N 673 673 

Temperatura 

Coeficiente de 
correlación -,120** 1,000 

Sig. (bilateral) ,002 . 
N 673 673 

**. La correlación es significativa al nivel 0,01 (bilateral). 
 

Fuente: Elaboración propia. 
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Gráfico 6. Dispersión lineal del año 2010 (Periodo Húmedo) 
Fuente: Elaboración propia. 

 

Tabla 44 

Correlación entre NDVI y Temperatura en el año 2015 (Periodo Húmedo) 

Fuente: Elaboración propia. 
 

 

Gráfico 7.Dispersión lineal del año 2015 (Periodo Húmedo) 
Fuente: Elaboración propia. 
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Correlaciones 
 NDVI Temperatura 

Rho de 
Spearman 

NDVI 

Coeficiente de 
correlación 1,000 ,106** 

Sig. (bilateral) . ,006 
N 673 673 

Temperatura 

Coeficiente de 
correlación ,106** 1,000 

Sig. (bilateral) ,006 . 
N 673 673 

**. La correlación es significativa al nivel 0,01 (bilateral). 
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Tabla 45 

Correlación entre NDVI y Temperatura en el año 2019 (Periodo Húmedo) 
Correlaciones 
 NDVI Temperatura 

Rho de 
Spearman 

NDVI 

Coeficiente de 
correlación 1,000 ,270** 

Sig. (bilateral) . ,000 
N 673 673 

Temperatura 

Coeficiente de 
correlación ,270** 1,000 

Sig. (bilateral) ,000 . 
N 673 673 

**. La correlación es significativa al nivel 0,01 (bilateral). 
Fuente: Elaboración propia. 

 

 
Gráfico 8.Dispersión lineal del año 2019 (Periodo Húmedo) 
Fuente: Elaboración propia. 

4.4.2. Correlación en Periodo Seco  
En los demás casos, si existe correlación altamente significativa (p-

valor<0.05), excepto en la correlación del año 86 (seco) que no es significativo (p-

valor> 0.05). 

Tabla 46 

Correlación entre NDVI y Temperatura en el año 1986 (Periodo Seco) 
Correlaciones 
 NDVI Temperatura 

Rho de 
Spearman 

NDVI 

Coeficiente de 
correlación 1,000 -,422** 

Sig. (bilateral) . ,000 
N 674 674 

Temperatura 

Coeficiente de 
correlación -,422** 1,000 

Sig. (bilateral) ,000 . 
N 674 674 

**. La correlación es significativa al nivel 0,01 (bilateral). 
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Fuente: Elaboración propia. 
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Gráfico 9. Dispersión lineal del año 1986 (Periodo Seco) 
Fuente: Elaboración propia. 

 

Tabla 47 

Correlación entre NDVI y Temperatura en el año 1995 (Periodo Seco) 
Correlaciones 
 NDVI Temperatura 

Rho de 
Spearman 

NDVI 

Coeficiente de 
correlación 1,000 -,222** 

Sig. (bilateral) . ,000 
N 673 673 

Temperatura 

Coeficiente de 
correlación -,222** 1,000 

Sig. (bilateral) ,000 . 
N 673 673 

**. La correlación es significativa al nivel 0,01 (bilateral). 
Fuente: Elaboración propia. 

 

 

Gráfico 10. Dispersión lineal del año 1995 (Periodo Seco) 
Fuente: Elaboración propia. 
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Tabla 48 

Correlación entre NDVI y Temperatura en el año 2005 (Periodo Seco) 
Correlaciones 

 NDVI Temperatura 

Rho de 
Spearman 

NDVI 

Coeficiente de 
correlación 1,000 -,003 

Sig. (bilateral) . ,929 
N 674 674 

Temperatura 

Coeficiente de 
correlación -,003 1,000 

Sig. (bilateral) ,929 . 
N 674 674 

Fuente: Elaboración propia. 
 

 

Gráfico 11. Dispersión lineal del año 1995 (Periodo Seco) 
Fuente: Elaboración propia. 

 

Tabla 49 
Correlación de Spearman entre NDVI y Temperatura en el año 2010 

(Periodo Seco) 
Correlaciones 

 NDVI Temperatura 

Rho de 
Spearman 

NDVI 

Coeficiente de 
correlación 1,000 ,290** 

Sig. (bilateral) . ,000 
N 673 673 

Temperatura 

Coeficiente de 
correlación ,290** 1,000 

Sig. (bilateral) ,000 . 
N 673 673 

**. La correlación es significativa al nivel 0,01 (bilateral). 
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Fuente: Elaboración propia. 
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Gráfico 12. Dispersión lineal del año 2010 (Periodo Seco) 
Fuente: Elaboración propia. 

 

Tabla 50  

Correlación entre NDVI y Temperatura en el año 2015(Periodo Seco) 
Correlaciones 
 NDVI Temperatura 

Rho de 
Spearman 

NDVI 

Coeficiente de 
correlación 1,000 ,280** 

Sig. (bilateral) . ,000 
N 355 355 

Temperatura 

Coeficiente de 
correlación ,280** 1,000 

Sig. (bilateral) ,000 . 
N 355 355 

**. La correlación es significativa al nivel 0,01 (bilateral). 
Fuente: Elaboración propia. 

 

 

Gráfico 13.Dispersión lineal del año 2015 (Periodo Seco) 
Fuente: Elaboración propia. 
 

 

 

 

 

y = -4.2378x + 21.976
R² = 0.01460

10

20

30

40

-0.2 -0.1 0 0.1 0.2 0.3 0.4Te
m

pe
ra

tu
ra

 (°
C)

NDVI

y = -3.1348x + 32.791
R² = 0.0073

0
10
20
30
40
50

-0.4 -0.3 -0.2 -0.1 0 0.1 0.2 0.3 0.4 0.5Te
m

pe
ra

tu
ra

 (°
C)

NDVI



Página 92 

 

 

 

Tabla 51 

Correlación de Spearman entre NDVI y Temperatura en el año 

2019(Periodo Seco) 

Correlaciones 
 NDVI Temperatura 

Rho de 
Spearman 

NDVI 

Coeficiente de 
correlación . . 

Sig. (bilateral) . . 
N 673 673 

Temperatura 

Coeficiente de 
correlación . 1,000 

Sig. (bilateral) . . 
N 673 673 

**. La correlación es significativa al nivel 0,01 (bilateral). 
Fuente: Elaboración propia. 

 

 
Gráfico 14.Dispersión lineal del año 2019 (Periodo Seco) 
Fuente: Elaboración propia. 

4.5. Determinación de Islas de calor Urbano 
4.5.1. Estimación de superficie en la ICU 

Entre ambos periodos los distritos con mayor grado de islas de calor 

urbano, según en la superficie es; Tacna y coronel Gregorio Albarracín Lanchipa, 

mediante las características de la cantidad poblacional y edificaciones la cual tiene 

mayor índice de temperatura.  

 

 

y = -3.9541x + 32.371
R² = 0.01120

10

20

30

40

50

-0.4 -0.3 -0.2 -0.1 0 0.1 0.2 0.3 0.4 0.5

Te
m

pe
ra

tu
ra

 (°
C)

NDVI



Página 93 

 

 

a. Periodo Húmedo  

Tabla 52 

Estimación de las superficies de las ICU en los distritos (Periodo Húmedo) 

Año 

 Superficie (km2) / Distritos 

Tacna Ciudad 
Nueva 

Alto de la 
Alianza 

Coronel 
Gregorio 
Albarracín 
Lanchipa 

 Pocollay Calana 

1985 0.282 5.815  2.921  4.643  3.921 3.734 
1995 - - - - - - 
2005 21.185 5.982  5.552  18.186 6.582  6.665 
2010 3.639  7.605  3.488 2.863 4.368 3.924 
2015 5.113  4.007  3.575 2.6  0.607  2.407 
2019 22.853  3.712  6.247  16.034  7.413  5.813 

Fuente: Elaboración propia. 
 

b. Periodo Seco  

Tabla 53 

Estimación de las superficies de las ICU en los distritos (Periodo Húmedo) 

Año 

Superficie (km2) / Distritos 

Distrito de 
Tacna 

D. Ciudad 
Nueva 

D. Alto de 
la Alianza 

D. coronel 
Gregorio 
Albarracín 
Lanchipa 

D. 
Pocollay D. Calana 

1986 - - - - - - 
1995 1.599 1.227 3.710 8.391 0.322 1.081 
2005 8.582 7.919 4.806 10.689 5.370 5.624 
2010 0.034 2.124 2.040 - 0.009 0.619 
2015 33.685 17.859 15.574 31.656 20.227 8.856 
2019 30.216 9.284 8.661 20.088 11.732 6.894 

Fuente: Elaboración propia. 
 

4.5.2. Vegetación y temperatura superficial en la ICU 
En la correlación de las variables; vegetación y temperatura, indica que la 

temperatura influye en la cantidad de vegetación y para calcular esta correlación, 

se utiliza Spearman donde influye de forma atípica. Donde ha habido una 

correlación positiva, es decir, que a mayor temperatura (húmeda y seca), ha 

disminuido la vegetación.  
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Cabe mencionar, en las tablas, explica que en el año 1985 y 1986 la 

vegetación no dependía de la temperatura, es decir, si esta aumentaba, no era 

necesario la vegetación, la cual había una correlación negativa. En los siguientes 

años comenzó a depender la una de la otra de forma positiva, es decir, si sube la 

temperatura, también disminuye la vegetación. 

a. Periodo Húmedo 

Tabla 54  

Estimación de las superficies de la vegetación y temperatura (Periodo 

Húmedo) 
 Superficie (km2) 

Fecha Veg.Sana Temperatura 
1985 2.537 1.847 
1995 1.111 - 
2005 1.106 29.40 
2010 0.838 11.69 
2015 0.130 4.67 
2019 0.240 50.86 

Fuente: Elaboración propia. 
 

 
Gráfico 15.Estimación de las superficies de la vegetación y temperatura 

(Periodo Húmedo) 
Fuente: Elaboración propia. 
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b. Periodo Seco 

Tabla 55 

Estimación de las superficies de la vegetación y temperatura (Periodo 

Seco) 

Fecha 

Superficie (km2) 

Veg. 
sana  Temperatura 

1986 3.954  - 
1995 2.938  3.335 
2005 2.457  11.00 
2010 1.294 2.79 
2015 0.506  44.15 
2019 0.382 48.20 

Fuente: Elaboración propia. 
 

 
Gráfico 16. Estimación de las superficies de la vegetación y temperatura 

(periodo seco) 
Fuente: Elaboración propia. 

 

4.5.3. Islas de Calor Urbano 
En todas las imágenes hay determinadas zonas que llaman la atención de 

manera inmediata porque ilustran claramente las posibles temperaturas 

superficial de diferentes tipos de cobertura. En el siguiente grafico se identifica 

algunas zonas de interés.  
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Mapa 5 

Zonas de Islas de Calor Urbano (ICU), 2019 (Periodo Húmedo) 

Fuente: Elaboración propia. 
Tabla 56 

Observación de los ICU,2019 (Periodo Húmedo) 
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Zona Ubicación        UTM Área Temperatura S E 

1 

Distrito de coronel 

Gregorio Albarracín 

Lanchipa 

“Zona urbana” 

369280 8006620 3.46402 37 °C 

2 
Distrito de Tacna 

“Zona urbana” 
367197 8006550 2.17686 37 °C 

3 

Distrito de coronel 

Gregorio Albarracín 

Lanchipa 

“Zona urbana” 

369181 8002420 1.5483 38°C 

4 

Distrito de coronel 

Gregorio Albarracín 

Lanchipa 

“PTAR de Copare” 

366370 8004700 0.318591 37°C 

5 
Distrito de ciudad nueva 

“Industrias” 
369148 8010130 3.81451 37°C 

6 
Distrito de Tacna 

“Estadio Jorge Basadre” 
367296 8008870 0.215316 37°C 

7 

Distrito de Tacna 

Entre las calles Los 

ángeles y San Jorge 

369280 8009300 0.15 37°C 

Fuente: Elaboración propia. 
 

Tabla 57 

Muestra fotográfica de las islas de calor urbano,2019 (Periodo Húmedo) 
Zona Fotografía Ubicación Temperatura 

1 

 

Distrito de 

coronel Gregorio 

Albarracín 

Lanchipa 

“Zona urbana” 

37°C 
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2 

 

Distrito de Tacna 

“Zona urbana” 

37°C 

 

3 

 

Distrito de 

coronel Gregorio 

Albarracín 

Lanchipa 

“Zona urbana” 

38°C 

 

4 

 

Distrito de 

coronel Gregorio 

Albarracín 

Lanchipa 

“PTAR de 

Copare” 

37°C 

5 

 

Distrito de ciudad 

nueva 

“Industrias” 

37°C 

6 

 

Distrito de Tacna 

“Estadio Jorge 

Basadre” 

37°C 



Página 99 

 

 

7 

 

Distrito de Tacna 

Entre las calles 

Los ángeles y 

San Jorge 

37°C 

Fuente: Elaboración propia. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Página 100 

 

 

Mapa 6 

Zonas de Islas de Calor Urbano (ICU), 2019 (Periodo Seco) 

 
Fuente: Elaboración propia. 
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Tabla 58  

Observación de los ICU,2019 (Periodo Seco) 

Zona Ubicación  
UTM 

Área Temperatura  
E S 

1 Distrito de Tacna 
“Zona urbana” 

366696 8006390 0.519 km2 38°C 

2 
Distrito de coronel 
Gregorio Albarracín 
Lanchipa  
“Terreno sin propiedad” 

366996 8002000 0.609 km2 38°C 

3 Distrito de Tacna 
“Zona urbana” 367036 8006210 1.06 km2 34°C 

4 Distrito de Tacna  
“Estadio Jorge 
Basadre” 

367082 8008800 0.214 km2 34°C 

5 
Distrito de coronel 
Gregorio Albarracín 
Lanchipa  
“PTAR de Copare” 

366344 8004590 1.643 km2 38°C 

6 Distrito ciudad nueva 
“zonas urbanas”  368808 8011210 0.500 km2 34°C 

7 Distrito Ciudad nueva 
“Terminal terrestre los 
incas” 

368356 8009840 0.7106 
km2 38°C 

Fuente: Elaboración propia. 
 

Tabla 59 

Muestra fotográfica de las islas de calor urbano,2019 (Periodo Seco) 
Zona Fotografía Ubicación Temperatura 

1 

 

Distrito de Tacna 

“Zona urbana” 
38°C 
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2 

 

Distrito de 

coronel Gregorio 

Albarracín 

Lanchipa 

“Terreno sin 

propiedad” 

38°C 

3 

 

Distrito de Tacna 

“Zona urbana” 

34°C 

 

4 

 

Distrito de Tacna 

“Estadio Jorge 

Basadre” 

34°C 

5 

 

Distrito de 

coronel Gregorio 

Albarracín 

Lanchipa 

“PTAR de 

Copare” 

38°C 
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6 

 

Distrito ciudad 

nueva 

“zonas urbanas” 

34°C 

7 

 

Distrito Ciudad 

nueva 

“Terminal 

terrestre los 

incas” 

38°C 

Fuente: Elaboración propia. 
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CAPÍTULO V: DISCUSIÓN  

Según (Soberón & Obregón, 2015), de título “Identificación de Islas de Calor en la 

Ciudad de Lima donde será utilizando por imágenes del Satélite Landsat 5 TM”, cuyo 

objetivo es identificar islas de calor urbanas superficiales en la ciudad de Lima 

Metropolitana, entre 2008 al 2011, debe relacionarse con la temperatura del aire (Senamhi) 

y la temperatura superficial. Así mismo el tamaño y estructura de la ciudad en los distritos 

de Ate y Lurigancho, en los distritos de Rímac y el Agustino se encontró 15 islas de calor, 

en cambio en nuestro trabajo por su tamaño y estructura es menor que Lima en la cual 

entre los dos periodos se encontraron 7 islas ubicados en el distrito de Tacna, distrito 

coronel Gregorio Albarracín Lanchipa y el distrito de Ciudad Nueva.  

El objetivo específico es determinar si las características térmicas de los materiales 

de construcción en las edificaciones tiene relación con la temperatura urbana, de acuerdo 

con la investigación científica y técnica; “Utilización de imágenes satelitales para el estudio 

de la distribución térmica en distintas coberturas del suelo de la ciudad de Bahía Blanca 

(Argentina) propuesta de los autores  (Ferrelli, Bustos, Huamantinco Cisneros, & Piccolo, 

2015) afirma que la temperatura tiene relación con el tipo de cobertura entre los espacios 

urbanos ya sea por su construcción que influye el tipo de material, aumenta su temperatura  

(45.1 °C), lo cual queda demostrado que en nuestro proyecto, para determinar la capacidad 

de almacenamiento de calor y su capacidad de transmisión de temperatura, se realiza dos 

fórmulas; calor específico volumétrico y la difusividad térmica según la conductividad 

térmica, densidad y calor especifico del tipo de material.  

Siguiendo con el segundo objetivo específico en establecer la relación que existe 

entre la escasez de vegetación con el aumento de islas de calor mediante el uso de 

imágenes satelitales, de acuerdo la tesis “Disminución de las áreas verdes, en la aparición 

de islas de calor en la ciudad de Iquitos entre los años 2004 – 2014. Región Loreto de 

(Francis, 2015) cuyo objetivo es la influencia de la disminución de áreas verdes con la 

aparición de islas de calor, dando que el resultado que ha disminuido en 20% de su 

vegetación en promedio desde el año 2005 hasta el 2014. En cambio, en nuestro trabajo 

demuestra que al ser de un clima semi ecuatorial ha reducido en 9% de vegetación entre 

1985 a 2019 influenciando que las islas de calor sean mayores que Iquitos.  

Nuestro objetivo específico final es determinar la relación existente entre las islas de 

calor con la temperatura superficial y el NDVI, en la Ciudad de Tacna, en la investigación 

científica de “Análisis de islas de calor urbano usando imágenes Landsat: caso de estudio 

Armenia-Colombia 1996-2018” propuesta por (Soto, Garzon, & Jimenez, 2019),se utiliza la 
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correlación de Person ya que es lineal dado que su resultado fue negativa, demuestra que 

si uno disminuye el otro también. En nuestro trabajo en las tablas de correlación de los dos 

periodos demuestran que en 1986(periodo seco) la vegetación no dependía de la 

temperatura, es decir si esta aumentaba, no necesitaba la vegetación y abría una 

correlación negativa. En cambio, el resto de los años demuestra que es significativa, es 

decir, que todas las variables de vegetación y temperatura están relacionadas, pero es 

atípica la cual indica que en el transcurso de los años hubo un crecimiento en la temperatura 

y una disminución en la vegetación.  
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CONCLUSIONES 

• Según los ambos periodos, el distrito de mayor índice de islas de calor es en 

el distrito de Tacna seguido del distrito coronel Gregorio Albarracín Lanchipa, 

se realizó las tablas y gráficos para estimar la cobertura de las islas de calor 

urbano cuya temperatura es mayor de 30°C, así mismo se realizó mapas 

como referencia. 

• Las características térmicas de los materiales de construcción (ladrillos, 

cemento, adobe, madera y tejas) tienen relación a la cobertura de áreas 

urbanas (edificaciones) ya sea por su capacidad de almacenamiento de calor 

y su capacidad de transmisión de temperatura, la cual es necesario obtener 

la conductividad térmica, densidad y calor especifico de cada tipo de 

material.  

• Al aumentar la temperatura disminuye la vegetación sana, como resultado 

en el periodo húmedo del año 2019 disminuyo su cobertura de vegetación a 

0.240 km2 y la cobertura de la temperatura aumento hasta 50.86 km2. En el 

periodo seco, llego su cobertura de vegetación a 0.382 km2 y la cobertura de 

temperatura a 48.20 km2 teniendo una probabilidad en encontrar zonas de 

islas de calor.  

• De acuerdo con el análisis estadístico de rho Sperman para su correlación 

de ambos periodos entre la temperatura y NDVI existe una correlación 

significativa de 0.05. 

• Para encontrar las islas de calor urbano según el periodo húmedo y seco, se 

utilizó la imagen satelital del año 2019, se encontraron 7 islas de cada uno 

en la ciudad de Tacna. 
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RECOMENDACIONES 

 

Para combatir las islas de calor urbano tener alternativas ambientales por el 

aumento de temperatura una de ellas es la plantación estrategia en los alrededores de la 

ciudad, tener una cuenta el tipo de árbol que se utilizará en los espacios urbanos.  

Se recomienda informar a las municipalidades de los distritos que tienen islas de 

calor urbana.   
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ANEXOS 

Mapa 7 

Estimación de ICU, 1985 (Periodo Húmedo) 

 
Fuente: Elaboración propia. 
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Mapa 8 

Estimación de ICU, 1995 (Periodo Húmedo) 

 
Fuente: Elaboración propia. 
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Mapa 9 

Estimación de ICU, 2005 (Periodo Húmedo) 

 
Fuente: Elaboración propia. 
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Mapa 10 

Estimación de ICU, 2010(Periodo Húmedo) 

 
Fuente: Elaboración propia. 
 

 



Página 116 

 

 

Mapa 11 

Estimación de ICU, 2015 (Periodo Húmedo) 

 
Fuente: Elaboración propia. 
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Mapa 12 

Estimación de ICU, 1986 (Periodo Seco) 

 
Fuente: Elaboración propia. 
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Mapa 13 

Estimación de ICU, 1995 (Periodo Seco) 

 
Fuente: Elaboración propia. 
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Mapa 14 

Estimación de ICU, 2005 (Periodo Seco) 

 
Fuente: Elaboración propia. 
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Mapa 15 

Estimación de ICU, 2010 (Periodo Seco) 

Fuente: Elaboración propia. 
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Mapa 16 

Estimación de ICU, 2015 (Periodo Seco) 

Fuente: Elaboración propia. 
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Mapa 17 

Estimación de ICU, 2010 (Periodo Seco) 

Fuente: Elaboración propia. 
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Mapa 18 

Indice de vegetación de diferencia normalizada, (Periodo Húmedo) 

Fuente: Elaboración propia. 
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Mapa 19 

Indice de vegetación de diferencia normalizada, (Periodo Seco) 

 
Fuente: Elaboración propia. 
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Mapa 20  

Temperatura superficial terrestre, (Periodo Húmedo) 

Fuente: Elaboración propia. 
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Mapa 21 

Temperatura superficial terrestre, (Periodos Seco) 

 
Fuente: Elaboración propia. 
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Mapa 22 

Correlación entre NDVI y TST, (Periodo Húmedo) 

Fuente: Elaboración propia. 
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Mapa 23 

Correlación entre NDVI y TST, (Periodo Seco) 

 
Fuente: Elaboración propia. 
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PANEL FOTOGRAFICO 

 

Zonas de Vegetación Sana en el Distrito de Tacna 

 

Zonas de Vegetación Sana en el Distrito de Pocollay 

 

 

 
 

PERIODO HUMEDO 

Lateral Paco Ayca 

E:368766, S:8008136 

UTM 

Avenida Celestino 
Vargas 

E:371962, S:8010950 

UTM 
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Zona de vegetación sana en el Distrito Crnl. Gregorio Albarracín Lanchipa 

 

 

Zona de vegetación sana en el Distrito de Calana 

 

                 
 

 

Tarapaca  

E:367810, S:8006025 

UTM 

Avenida Celestino 
Vargas 

E: 374325.00, S: 
8013372 
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Zonas de Vegetación Sana en el Distrito de Tacna 

 

Zonas de Vegetación Sana en el Distrito de Pocollay 

 

 

Parque ecológico 
Deportivo Gustavo 

Mohme Llona 
E:368989, S:8006987 

UTM 

Plaza de Pocollay 

E:370851, S:8009847 

UTM 

PERIODO SECO 
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Zona de vegetación sana en el Distrito Crnl. Gregorio Albarracín Lanchipa 

 

Zona de vegetación sana en el Distrito de Calana 

 

 

 

Avenida 
Educadores 

E:366374, S:8005414 

UTM 

Calana 

E: 373595, S: 8012429 

UTM 
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Formato de solicitud de Servicio Nacional de Meteorología e hidrología del Perú 
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Tabla 60  

Estación Jorge Basadre - Variables Hidrometeorológica en Humedad Relativa  

Fuente: Servicio Nacional de Meteorología e hidrología del Perú (Senahmi) 
 

 JORGE BASADRE: HUMEDAD RELATIVA MENDIA MENSUAL 

 AÑO ENE FEB MAR ABR MAY JUN JUL AGO SEP OCT NOV DIC 

HR101 1995 63.74 66.99 69.22 74.34 76.39 78.29 78.29 81.31 82.52 79.59 77.46 75.53 

HR101 2005 73.01 74.68 74.36 77.2 80.23 81.01 81.27 80.13 81.18 76.46 72.82 69.9 

HR101 2010 68.34 - 69.28 75.48 79.5 82.92 81.21 80.23 82.49 75.56 78.68 74.45 

HR101 2015 72.33 69.84 71.38 76.43 81.7 82.76 83.95 84.75 82.44 85.14 83.61 82.29 

HR101 2019 - 74.22 76.44 78.47 82.55 86.65 87.94 88.66 88.23 80.17 - - 
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Tabla 61 

Estación Jorge Basadre - Variables Hidrometeorológica en Precipitación Total 

Mensual 
 JORGE BASADRE: PRECIPITACION TOTAL MENSUAL 

 AÑO ENE FEB MAR ABR MAY JUN JUL AGO SEP OCT NOV DIC 

PT101 1995 0.3 0 6 0 0.1 0 0.8 1.5 2.1 0.4 0 0 

PT101 2005 0.3 0.1 0 0.8 0.5 0 0.4 2.2 4.1 0 0  - 

PT101 2010 0.1 0 0 2.2  - 1.4 0 0.6 1.6 0  - 0.1 

PT101 2015 0.6 0.9 1.8 0 3.7 0 3.8 10.8 5.6 7.4 1.8 2.4 

PT101 2019 14.2 8.3 0 0.2 0.4 1.3 6.3 0.3 4.8 3.1 0.9 0 

Fuente: Servicio Nacional de Meteorología e hidrología del Perú (Senahmi) 
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Tabla 62 

Estación Jorge Basadre - Variables Hidrometeorológica en Temperatura Máxima 
JORGE BASADRE: TEMPERATURA MAXIMA MENSUAL 

 AÑO ENE FEB MAR ABR MAY JUN JUL AGO SEP OCT NOV DIC 

TM102 1995 28.51 27.95 27.16 24.85 22.19 20.66 19.1 19.26 21.17 23.1 24.63 25.54 

TM102 2005 28.02 27.05 26.72 24.17 21.23 20.4 18.73 19.8 19.84 21.54 24.32 26.14 

TM102 2010 27.87 29.09 27.24 24.86 22.2 18.83 17.73 19.18 20.27 22.05 24.1 25.54 

TM102 2015 27.3 28.64 28.66 25.86 22.73 20.97 19.65 20.53 22.7 23.43 25.03 27.03 

TM102 2019 28.12 29.11 27.41 24.74 21.88 19.87 18.32 19.91 20.54 22.36 24.88 26.84 

Fuente: Servicio Nacional de Meteorología e hidrología del Perú (Senahmi)
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Tabla 63 

Estación Jorge Basadre - Variables Hidrometeorológica en Temperatura Media 
JORGE BASADRE: TEMPERATURA MEDIA MENSUAL 

 AÑO ENE FEB MAR ABR MAY JUN JUL AGO SEP OCT NOV DIC 

TM101 1995 22.91 21.6 21.2 18.79 16.32 14.51 13.64 13.62 15.28 16.59 18.26 19.29 

TM101 2005 22.25 21.21 20.63 18.43 15.62 14.04 13.4 13.8 14.03 15.36 17.94 20.21 

TM101 2010 21.56  20.95 19.62 17.65 13.8 12.11 13.18 14.41 15.94 17.66 19.15 

TM101 2015 21.44 23.24 23.18 20.73 18.15 16.1 14.64 14.98 16.81 17.42 18.7 20.57 

TM101 2019 22.41 23.28 21.62 19.57 16.6 15.01 13.75 14.24 15.18 16.28 19.07  

Fuente: Servicio Nacional de Meteorología e hidrología del Perú (Senahmi)
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Tabla 64 

Estación Jorge Basadre - Variables Hidrometeorológica en Temperatura Mínima 
JORGE BASADRE: TEMPERATURA MINIMA MENSUAL 

 AÑO ENE FEB MAR ABR MAY JUN JUL AGO SEP OCT NOV DIC 

TM103 1995 17.75 16.77 16.62 14.37 11.88 10.77 9.76 9.73 11.8 12.61 13.87 14.64 

TM103 2005 17.47 16.93 15.81 13.98 11.96 9.76 9.94 10.05 10.36 11.22 13.29 15.52 

TM103 2010 15.94 17.1 15.67 15.77 13.57 10.42 8.09 9.03 10.43 11.76 12.96 13.75 

TM103 2015 16.9 18.81 18.46 16.56 15.01 12.68 11.38 11.49 12.78 13.84 14.72 16.39 

TM103 2019 17.95 18.95 16.62 15.41 12.88 11.65 11.01 9.97 11.22 11.97 14.8 16.3 

Fuente: Servicio Nacional de Meteorología e hidrología del Perú (Senahmi)
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MATRIZ DE CONSISTENCIA 

Título Probable “Determinación de Islas de Calor Urbano en la Ciudad de Tacna, mediante el uso de imágenes satelitales” 
Problema General Objetivo General Hipótesis General Variables Dimensión Indicador Metodología 

¿Cómo determinar 
Islas de calor urbano 
en la Ciudad de Tacna? 

Realizar un análisis 
comparativo de las 
imágenes satelitales entre 
los periodos de 1985 y 
2019, para determinar Islas 
de Calor Urbano en los 
diferentes distritos de la 
ciudad de Tacna.  

H: Existen una variación de 
temperatura entre los años 
1985 y 2019, para 
determinar Islas de Calor 
Urbano en la Ciudad de 
Tacna  

V.I: Temperatura, 
imágenes satelitales 

Ciudad de 
Tacna > 30 °C 

Procesamiento de imágenes 
satelitales Landsat, técnica de 
regresión lineal 

V.D: Islas de Calor 
Urbano 

Problemas Específicos Objetivos Específicos Hipótesis Específicas Variables Dimensión Indicador Metodología 
¿Cuáles son las 
características 
térmicas de los 
materiales de 
construcción y como 
están relacionados con 
la temperatura urbana? 

Determinar las 
características térmicas de 
los materiales de 
construcción y establecer 
su relación con la 
temperatura urbana. 

H1: Las Islas de Calor 
están relacionadas 
significativamente con las 
propiedades de los 
materiales de construcción. 

V.I: Temperatura, 
imágenes satelitales 

Ciudad de 
Tacna 

> 30 °C 
Procesamiento de imágenes 
satelitales Landsat, técnica de 
regresión lineal V.D: Islas de Calor 

Urbano 

¿En qué medida la 
escasez de vegetación 
se relaciona con el 
aumento de Islas de 
Calor? 

Establecer la relación que 
existe entre la escasez de 
vegetación con el aumento 
de islas de calor mediante 
la generación de algoritmos 
con el uso de imágenes 
satelitales. 

H2: Existe una relación 
significativa entre la 
escasez de vegetación con 
el aumento de islas de 
calor. 

V.I: vegetación, 
imágenes satelitales NDVI 

Procesamiento de imágenes 
satelitales Landsat, técnica de 
regresión lineal V.D:  Islas de Calor 

Urbano   

¿Cómo se relaciona la 
temperatura superficial 
y el NDVI en las Islas 
de Calor? 

Determinar la relación 
existente entre las islas de 
calor y con la temperatura 
superficial y NDVI, en la 
Ciudad de Tacna 

H3: Las islas de calor se 
relacionan 
significativamente con la 
temperatura superficial, y 
NDVI. 

V.I: Temperatura 
superficial, 
vegetación, 
imágenes satelitales 

> 30 °C, 
NDVI Procesamiento de imágenes 

satelitales Landsat, técnica de 
regresión lineal 

V.D: Islas de Calor 
Urbano                                                                                                                                                                                                                                                                                                                                     
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